
 

 

 

 

 

 

 

 

 

 

 

 

 



ArcGIS 10  
Uygulama 1 :  

1. Başlat> Tüm Programlar > ArcGIS 10 > ArcMap 10  üzerine çift tıklayınız.  
 

 

ArcMap arayüzü açıldığında karşınıza  ilk olarak aşağıdaki pencere çıkacaktır.  

 

 

 

 

 

 

2. Bu pencereyi Open butonuna basarak kapatınız.  

Getting Started penceresi kapandıktan sonra ArcMap arayüzü ile karşılaşacaksınız. 

 

Bu bölümde kullanıcının daha önce üzerinde çalışmış olduğu 
harita dökümanları listelenmektedir. Kullanıcı dilerse buradan 
önceki harita dökümanlarını açıp, üzerinde çalışmaya 
başlayabilir.  

ArcGIS 10’dan itibaren program ile 
oluşturulan tüm  objelerin belirlenen 
dizinde saklanması için bir default 
geodatabase oluşturulmuştur.  

Harita çıktı 
işlemlerine 
hazır bir 
şablonu 
sadece 
okunabilir 
olarak 
görüntülemek 
ya da yeni bir 
şablon 
oluşturmak 
için kullanılır. 



 

 

 

3. File menüsünün altından Open’a veya Standard Toolbardaki Open   ikonuna tıklayınız.  
ArcGIS10_Egitim/Uygulama_01 dosyasında yer alan Uygulama_01.mxd’yi açınız.  
Proje dosyası (.mxd) içerisinde yer alan veriler; Dünya ülkeleri, Türkiye il sınırları, Türkiye 
Demiryolları ve Yerleşimler katmanlarıdır.   
 
 
ArcMap’te Semboloji Değiştirme ; 
 

4. ArcMap ortamında Table of Contents menüsünde yer alan katmanların renk ve semboloji 
değişikliklerini yapmak için; Table of Contents’de yer alan Ulkeler katmanının poligon sembolü 
üzerinde mouse’ın sağ butonuna tıklayınız.  

 

Main Menu 

StandardToolbar 

Tools Toolbar 

Table of Contents Data View/Layout View 
ekranı 



5. Renk paletinden dilediğiniz rengi seçiniz.  Ülkeler katmanına ait olan tüm objelerin seçtiğiniz 
rengi aldığını göreceksiniz.  Aynı işlemi diğer katmanlar için de uygulayabilirsiniz.  

6. Semboloji değişikliği için; Table of Contents menüsünde yer alan Demiryolu katmanının çizgi 
sembolü üzerinde mouse’ın sol butonuna basınız.  

 

7. Açılan Symbol Selector penceresindeki RailRoad sembolünü seçip rengini kırmızı, kalınlığını da 6 
olarak ayarlayınız ve OK butonuna tıklayınız.  

 

8. Table of Contents menüsünde yer alan Yerlesim katmanının nokta sembolü üzerinde de 
mouse’ın sol tuşuna tıklayınız.  

9. Açılan Symbol Selector penceresindeki Search  kutusuna  location monument yazıp enter’a 
basınız.  

 



10. Location Monument sembolünü seçip OK butonuna tıklayınız.  

 

        Tools Toolbar Fonksiyonları ile Çalışma; 

      

 

       

 

 

 

 

 
       Bu uygulamada Tools Toolbar’daki fonksiyonlar kullanılarak bir ülke bulunacaktır.   

11. Full Extent  aracına tıklayınız ve tüm verinin ekran sınırına yerleşmesini sağlayınız.  

12. Zoom In  aracıyla Asya kıtasına yaklaşınız. Aradığımız ilk ülke Asya kıtasında bulunmaktadır.  

 

13. Bu ülke 93o 51ı 14.4 ıı E ve 30o 17ı 6ıı N koordinatlarına sahip olan ülkenin güneyindeki adalardan 

birisidir. Bu koordinatlara sahip olan ülkeyi bulmak için Go to XY  aracına tıklayınız.  
14. Açılan Go to XY penceresine yukarıda belirtilen koordinatları yazıp Enter’a basınız.   

 

 

Zoom In  

Zoom Out 

Pan  

Full Extent  

Fixed Zoom 
In 

Fixed Zoom 
Out 

Go Back to 
Previous Extent 

Go to Next Extent 

Selection 

Select 
Elements 

Identify 

Hyperlink 

HTML Popup 

Measure 

Find 

Find Route 

Go to XY 

Time Slider 

Viewer 



15. Daha sonra bu koordinatların güneyine Zoom In  aracını seçerek yeniden yaklaşınız.  
 

 
 

16. Ülkenin adı ‘ezya’ harfleri ile son bulmaktadır.  İçerisinde ezya harfleri bulunan ülkeleri 

görüntülemek için Find  aracına tıklayınız.  Aşağıdaki ayarları yapınız ve Find butonuna 
tıklayınız.  

 
 
Find butonuna tıkladıktan sonra aşağıda 2 adet ülke listelenecektir. (Endonezya ve Malezya) 
 

17. Aradığımız ülkenin nüfusu 19.626.380, para tipi ise Ringgit’tir.  Bu özellikleri görüntülemek için 
öncelikle Endonezya üzerinde sağ tıklayınız ve Zoom to seçeneğine tıklayınız.  
 

 



18. Daha sonra identify  aracını seçiniz ve Endonezya üzerinde tekrar tıklayınız. Açılan Identify 
penceresindeki nüfüs ve para tipi kayıtlarını kontrol ediniz.  
 

 
 
Bu kontrol sonrasında Endonezyanın aradığımız kriterleri karşılamadığını göreceksiniz.  
 

19. Identify penceresinin yerini değiştirirken ekranda çıkan okların üzerine koyarak arayüze 
yerleşmesini sağlayabilirsiniz.  Bu sayede identify penceresinin kullanılmadığı durumlarda 
saklanmasını sağlamış olursunuz.  
 

 
 

20. Identify aracıyla bu sefer Malezya üzerine tıklayınız ve identify penceresinden verilen kriterlere 
uygun olup olmadığını kontrol ediniz.  
 
Kontrol sonucunda aradığımız ülkenin Malezya olduğu anlaşılacaktır.  



21. Bu aşamada Malezya’nın fotoğrafı eklenecektir. Bunun için Identify penceresindeki MY adı 
üzerinde sağ tıklayınız ve Add Hyperlink’i seçiniz.  
 

 
 

22. Açılan pencerede  butonuna tıklayınız. Eklemek istediğimiz resim ArcGIS10_EGITIM > 
Uygulama_01 > Hyperlink  dizinin içerisindeki Malezya.jpg dosyasıdır. Dosyayı seçip Open 
aracına daha sonra OK butonuna tıklayınız.  

 
 

23. Bu işlemden sonra Tools Toolbardaki Hyperlink aracı  aktif hale gelecektir. Hyperlink aracına 
tıkladıktan sonra Malezya üzerine tekrar tıklayınız. Resmin ekranda açıldığını göreceksiniz.  
 

 
Resmi kapatınız. 
 



24. İstenilen bir web sitesini ekran üzerinde tıklandığında görüntülemek içinse HTML Popup 
fonksiyonu kullanılmaktadır.  Bunun için Table of Contents’de bulunan Ulkeler katmanında sağ 
tıklayınız ve Properties seçeneğine tıklayınız.  
 

 
 

25. Açılan Layer Properties penceresinde HTML Popup sekmesine tıklayınız ve ayarları aşağıdaki 
şekildeki gibi yapınız ve OK butonuna tıklayınız.  
 

 
 



26. Daha sonra Tools Toolbar’daki HTML Popup  aracına tıklayıp, Malezya üzerine tekrar 
tıklayınız. Web sitesinin açıldığını göreceksiniz.  
 

 
 
Açılan pencereyi kapatınız.  
 

27. Malezya’ya bir sonraki uygulamada tekrar geri dönmek için, şu anda ekranda olan görüntüyü 
Bookmark olarak kaydetmemiz gerekmektedir. Bunun için Main Menu’deki Bookmarks 
menüsünün altından Create seçeneğine tıklayınız.  
 

 
 

28. Açılan Bookmark penceresinde Bookmark 1 yazan yere Malezya yazıp OK butonuna tıklayınız.  
 

 
 

29. ArcMap’i kaydetmeden kapatınız. 
 
 
 
 
 
 



 

  Uygulama 2 : 

  ArcMap’te Raster Verilerin Görüntülenmesi ; 

 Raster Veri hücrelere bağlı olarak temsil edilen verilerdir. En küçük birim piksel olarak 
tanımlanmaktadır. Raster verilerde verinin hassasiyeti piksel boyutuna göre değişen çözünürlük 
(resolution) özelliği ile tanımlanmaktadır.  

 

 Bu uygulamada, Türkiye ve komşularını içeren 1km hassasiyette üretilmiş olan Sayısal Yükseklik 
Modelinin (DEM)  sınıflandırılması ve Türkiye il vektörel katmanına transparanlık özelliği katılarak 
verilerin birbirleri ile etkileşimli olarak görüntülenmesi sağlanacaktır.  

1. Başlat > Tüm Programlar > ArcGIS > ArcMap10’u açınız. 
 

 
 

2. ArcGIS10_EGITIM/Uygulama_02 dosyasının içerisinde yer alan Uygulama_02.mxd’yi açınız.   
Table of Contents’de Turkiye, Turkiye_dem ve Turkiye_hill katmanları bulunmaktadır. Ancak 
sadece Turkiye_hill katmanının çeki atılı olduğu için bu katman Data View penceresinde 
görüntülenmektedir.  
 

 
 
 

3. Table of Contents’de bulunan Turkiye_dem katmanının çekini atarak görüntülenmesini 
sağlayınız.  

Vektörel Katman 

Raster Katman; DEM (Digital Elevation Model- Sayısal 
Yükseklik Modeli ): GRID formatındaki bu tür veriler VAT 
(Value Attribute Table) dosyasında x,y koordinatları ve 
yükseklik bilgilerini içermektedir.  

Raster Katman; Hillshade (Kabartma Haritası ): Kabartma haritaları 
DEM’den oluşturulmakta ve sadece arazi topoğrafyasını temsil etmesi 
için kullanılmaktadır. Yükseklik bilgisi içermez 



 
 

4. Table of Contents’de bulunan Turkiye_dem katmanı üzerinde mouse’ın sağ tuşuna tıklayınız ve 
Properties seçeneğine tıklayınız.  
 

 
5. Açılan Layer Properties penceresinde  Symbology sekmesini tıklayınız.  

 
6. Color ramp menüsünden dilediğiniz bir renk aralığını seçip, Display Background Value 

kutusunun çekini atınız ve as menüsünden yükseklik değeri sıfır olan yerler (denizler) için mavi 
rengini seçiniz.  
 

7. Apply butonuna basınız. Türkiye_dem katmanı yükseklik değerlerine göre renklendirilmiş oldu. 
Turkiye_hill katmanının da yükseklik haritası altında topoğrafyayı göstermesi için Turkiye_dem’e 
şeffaflık vermek gerekmektedir.  
 



 
 

8. Katmana transparanlık vermek için Display sekmesine tıklayınız.  Transparency kutusuna 50  
rakamını giriniz. Bu işlem,  katmanın %50 şeffaf olmasını sağlayacaktır.   
 

 
 

9. OK butonuna basıp yaptığınız değişikleri inceleyiniz.  
 



 
 

Haritaya BaseMap Eklenmesi; 

 Haritaları oluştururken kullanıcının amacı, yüksek performanslı ve yüksek kalitede kartografik 
sunumlar elde etmektir. ESRI’nin sunduğu Basemap haritaları bu tür sunumlar elde etmenin en kolay 
yollarından birisidir.  

1. Table of Contens menüsündeki turkiye_dem ve turkiye_hill katmanlarının çekini kaldırıp, 
turkiye katmanının çekini atınız.  

2. Add Data menüsünden Add Basemap seçeneğine tıklayınız.   
 

 
 
Açılan pencerede ESRI’nin sunmuş olduğu ve haritalarınıza altlık olarak kullanabileceğiniz 
Basemap haritalar listelenmektedir.  
 

 



 
3. Listeden Bing Maps Aerial altlığını seçip Add butonuna tıklayınız.  

4. Ankara’ya  Zoom in   aracıyle yaklaşınız. Microsoft’un sunmuş olduğu Bing Maps haritalarını 
ücretsiz olarak haritanızın altında görüntüleyebileceğinizi görmektesiniz.   

5. ArcMap’i kaydetmeden kapatınız. 
 

 

Uygulama 3: 

Vektör Veri Tipleri (Shapefile, Coverages, Feature Class ve CAD); 

 Vektör veri, noktalara (x,y) bağlı olarak temsil edilen verilerdir. Konuma ait verilerin, nokta, çizgi 
ve alan özellikleri  x,y koordinat değerleriyle depolanmaktadır. Nokta özelliği, tek bir x,y koordinat çifti ile 
temsil edilmekte (Elektrik direkleri, kuyu noktaları, yangın muslukları gibi); çizgi özelliği,bir başlangıç ve 
bir bitiş noktası olan x,y koordinat dizisi ile temsil edilmekte(dere, yol, elektrik hatları gibi); alan özelliği 
ise, başlangıç ve bitiş noktası aynı olan x,y koordinatlar dizisi ile temsil edilmektedir (parsel, bina, arazi 
kullanımı gibi). 

 

 

 Vektörel veriler için iki temel depolama yöntemi vardır: Spagetti ve Topolojik veri modelleri  

Spagetti Veri Depolama Yöntemi; 

 Spagetti veri depolama yönteminde, nokta, çizgi ve alan türündeki vektör veriler, temsil ettikleri 
detayı oluşturan nokta ya da noktalar kümesi şeklinde detayı tanımlayan tek anlamlı bir kod (detay kodu) 
ve detay türü (nokta, çizgi, alan) ile birlikte depolanır. Aynı ya da farklı detayların çakışması ya da komşu 
olması durumlarında ortak kenar ve/veya noktalar her detay tekrarlanarak depolanır.  

Topolojik Veri Depolama Yöntemi; 

 Topolojik veri depolama yönteminde, detaylar arasındaki komşuluk, yön, çakışma,bağlantı gibi 
mekansal ilişkiler tanımlanır. Ayrıca komşu, kesişen ve çakışan detayların ortak nokta ve kenarları bir kez 
daha depolanarak, spagetti yönteminde karşılaşılan binme, boşluk, kopukluk taşma gibi gibi geometrik 
hatalar elemine edilmiş olur.  

 ESRI vektör formatları (Coverage, Shapefile ve Feature Class) topolojik veri modellerine birer 
örnektir.  



 Bu uygulamada, vektörel verilerin görüntüleme özellikleri (Layer Properties ve Data Frame 
Properties) ve harita çıktı işlemleri gerçekleştirilecektir.  

1. ArcGIS10_EGITIM/Uygulama_03 doyasında yer alan Uygulama_03.mxd’yi ArcMap 10’da açınız.  
 

 
 
Table of Contents’de Ankara köyler, Türkiye il merkez, Türkiye demir yolları, Türkiye nehir, 
Türkiye otoyollar, Türkiye göller ve Türkiye il vektörel katmanlarının olduğunu göreceksiniz. Aynı 
zamanda Bir önceki uygulamada bahsedilen Türkiye Hillshade (kabartma) ve Türkiye DEM 
(yükseklik modeli) raster verileri de yer almaktadır. Bu katmanlar üzerinde Layer Properties 
penceresi kullanılarak değişikler yapılacak ve harita çıktıya hazırlanacaktır.  

        Katman Özellikleri Penceresi; 

Uygulama_03.mxd içerisinde Table of Contents’de bulunan vektör ve raster verilere ait katman 
özellikleri (Layer Properties) penceresi bulunmaktadır. Bu pencerede verinin Raster veya Vektör veri 
olmasına göre değişen sekmeler gelmektedir. Aşağıdaki ekran kopyasında göründüğü şekilde bir 
vektör verinin katman özelliklerinden General, Source, Selection, Display, Symbology, Fields, 
Definition Query, Labels, Joins&Relates,Time*,HTML Popup seçenekleri ayarlanabilir. Raster verilerin 
katman özelliklerinde ise Selection, Label ve Definition Query seçenekleri veri yapısının vektör 
veriden farklı olmasından dolayı bulunmamaktadir. 

2. İlk olarak Table of Contents’de bulunan katmanların katman isimleri değiştirilecektir. Bunun için 
Table of Contents’de bulunan herbir katman üzerinde mouse’un sağ tuşuna tıklayarak Layer 
Properties seçeneğine geliniz. General sekmesinde bulunan Layer Name ile katman adını 
değiştiriniz. Değişiklikleri aşağıdaki gibi yapınız; 
 

• Turkiye_AnkKoy Ankara Köyler 

• Turkiye_ilMerkez Türkiye İl Merkezleri 

• Turkiye_Demiryolu Demiryolu 

• Turkiye_Nehir  Nehir 

• Turkiye_Otoyol  Otoyol 

• Turkiye_Gol  Göl 

• Turkiye_il  İl Sınırları 

• Turkiye_Dem  Yükseklik Kuşakları 

• Turkiye_hill  Türkiye Kabartma 

 



 

 

 

 

 

 
 
 

3. Yükseklik Kuşakları katmanının katman özelliklerinde Display sekmesine geliniz. Burada 
katmana ait görüntüleme özelliklerini düzenleyebilirsiniz. DEM katmanının yükseklik kuşaklarına 
ait semboloji ile kabartı haritasının birlikte görsellik kazanması için Table of Contents’de üstte 
bulunan Yükseklik Kuşakları katmanının Transparent kısmını %50 olarak ayarlayınız. 



 

 

4. Display’in hemen yanında bulunan Symbology sekmesini tıklayınız. Burada Yükselik Kuşaklarının 
renk aralığını değiştiriniz. Color Ramp seçeneğini tıklayarak renk tanımlaması yapınız (13. Sırada 
bulunan renk aralığı). Display Background Value özelliğine ait tiki atınız ve kutucuk içinde 0 
yazdığından emin olunuz, başka bir değer yazıyorsa 0(sıfır) yazınız ve ‘as’ seçeneğini mavi değer 
olarak belirleyiniz. Bu ayarlamalar ile DEM haritasında yükselik değeri 0 olan yerleri(denizler 0 
kotundadır) mavi renkte göstermektesiniz. OK’i tıklayınız. 



 

5. Göl katmanının sembolünü değiştirmek için ona ait sembol üzerinde mouse’un sol tuşuna 
basınız. Karşınıza açılan Symbol Selector penceresinden “Lake” sembolünü seçerek OK’e 
tıklayınız. 

 

6. Demiryolu katmanının sembolünü de aynı şekilde altındaki sembole tıklayarak değiştiriniz. Fakat 
bu sefer açılan Symbol Selector penceresinde yukarıda bulunan arama boşluğuna (Type here to 
search) “Railroad” yazarak klavyenizden Enter’a tıklayınız. Sembol penceresinde isminde railroad 
bulunan tüm semboller ekrana gelecektir. Pencereyi aşağıya doğru kaydırarak ESRI semboloji 
kütüphanesi altında bulunan railroad sembolünü seçiniz ve OK’e tıklayınız. 



 

7. Nehir katmanının da aynı şekilde sembolünü tıklayarak Symbol Selector penceresindeki “River” 
sembolünü seçiniz. Eğer River sembolünü ilk açtığınız ekranda göremiyorsanız arama 
kutucuğundan aratarak bulabilirsiniz. 

8. İl sınırları katmanının sembolünü değiştirmek istiyoruz fakat bu değişikliği İl isimlerine göre 
yapmak istiyoruz. Bunun için İl Sınırları katmanı üzerinde sağ tıklayarak Properties’i seçiniz.  
Açılan Layer Properties penceresinde Symbology sekmesini seçiniz ve Categories altında 
bulunan Unique Values fonksiyonunu tıklayınız. Value Field olarak İl sınırları katmanının 
öznitelik tablosunda bulunan ADI değerini seçiniz. 
 

 



Adına göre sembolojiyi kategorize etmek için Add All Values butonuna tıklayınız. Böylece seçilen 
renk aralığına göre tüm değerler ayrı ayrı kategorize edilmiş olarak ekrana gelecektir. Apply 
butonuna tıklayınız. 
 
9. İl sınırları katmanının Layer Properties penceresinde Display sekmesini tıklayınız ve Transparent 

kısmından  %50 şeffaflık ayarlayınız.  
“Show MapTips using the display expression” seçeneğinin yanındaki kutucuğa tik atınız ve 
hemen üstündeki Field fonksiyonuna ADI değerini getiriniz. Apply butonuna tıklayınız. 
ArcGIS 10 verisonundan itibaren birden fazla öznitelik değerine göre, MapTips özelliği Expression 
yazılarak eklenebilmektedir. 
 

 
 

10. İl sınırları katmanında Labels sekmesine tıklayınız. Bu işlem ile, il sınırları alan katmanı üzerine 
öznitelik tablosundaki değerler yazdırılabilecektir. Bu etiketlendirme işlemini yapabilmek için 
Labels sekmesinde Label features in this layer ifadesinin yanındaki kutuya tik atınız. Text String 
fonksiyonunda etiketlendirmeyi hangi öznitelik değerine göre yapmak istediğinizi 
belirleyebilirsiniz. İl isimlerini katman üzerine etiketlendirme yapmak için Label Field olarak ADI 
field’ını seçiniz. 

 



11. Etiketin katman üzerindeki sembol duruşunu değiştirmek için Symbol aracına tıklayınız ve 
istediğiniz bir Text sembolünü seçtikten sonra OK butonuna tıklayınız. 

12. Yaptığınız değişiklikler ekranda görüntülenmektedir. Tools araç çubuğunda bulunan Zoom In ve 
Zoom Out araçlarını kullanarak değişiklikleri inceleyiniz. Show MapTips fonksiyonu ile Labels 
arasındaki farkları incelemek için mouse il sınırları üzerinde bir yerde sabit tutunuz. 

13. Tüm değişiklikler ile birlikte çalıştığınız projeyi File > Save As ile 
C:/ArcGIS10_EGITIM/Uygulama03/Uygulama03_1.mxd olarak kaydediniz. ArcMap’i kapatınız. 
 
 

Joins & Relates & Symbology; 

Adım 1 : Joins 

1. ArcMap10’da boş bir proje sayfası açınız. 
 

 
 

2.  aracını tıklayarak C:/ArcGIS10_EGITIM/Uygulama03/Turkiye.mdb personal 
geodatabase içinde bulunan Turkiye_il polygon feature class’ı, Türkiye_Nufus2000, 
Turkiye_Saglik, Turkiye_Secim95 tablolarını klavyeden CTRL tuşuna basılı haldeyken çoklu olarak 
seçiniz. Add butonuna tıklayarak ekleyiniz. 

 

3. Grafiksel olmayan tablo verileriyle birlikte katmanlar eklendiğinde Table of Contents’deki menü 

seçeneği “List By Drawing Order ” dan “List By Source ”a otomatik olarak değişir. Bunun 
nedeni, sembolojisini değiştirebileceğimiz grafiksel verilerle beraber sadece öznitelik değerleri 
olan tabloların da ArcMap’e eklenebilmesidir. 

 



 
 

4. Tools araç çubuğundaki Identify  aracıyla Türkiye_il katmanından Eskişehir’i tıklayınız. 
Identify penceresinde Turkiye_il öznitelik tablosunda Eskişehir’in bulunduğu veritabanı bilgilerini 
Identify Result penceresine getirmektedir. Identify penceresinin mavi başlığı üzerinde mouse’a 
basılı haldeyken ekran üzerinde bir yere taşıyabilirsiniz. Diğer pencere arayüzleri gibi Identify’da 
otomatik olarak arayüze yerleştirilebilir ve gerektiğinde saklanabilmektedir.  
 

 
 

5. Türkiye_il katmanının veritabanında ADI, YERLESIMKO, IL vs. bilgiler bulunmaktadır. Aynı şekilde 
Nufüs2000 tablosu üzerinde sağ tıklayarak öznitelik tablosunu açınız. 
 

 



6. 2000 yılına ait nüfus tablosu aşağıdaki gibidir. Bu tablo içerisinde IL, ILADI, NUFUS_2000 ve 
YERLESIMKOD fieldları bulunmaktadır. Türkiye_il katmanınında öznitelik tablosunu açınız. 
Turkiye_il tablosu ile Nufus2000 tablolarını Join ile birleştirmek için ortak bir field’a ihtiyacımız 
vardır. 

     

Turkiye_il katmanı öznitelik tablosuna Turkiye_Nufus2000 tablosunu join etmek için kullanılacak ortak 
field YERLESIMKOD sütunudur. Değerleri kontrol ettiğimiz zaman aynı illerin aynı yerleşimkod değerine 
sahip oldukları görülecektir.  

7. Turkiye_il katmanı üzerinde mouse ile sağ tıklayarak Layer Properties penceresini açınız. 
Joins&Relates sekmesini tıklayınız. Joins kısmında Add butonuna tıklayınız. 

 



Açılan pencerede ayarları üstteki gibi yapınız ve  Validate Join butonuna tıklayınız. ArcGIS 10 ile 
gelen bu özellik ile, Join işlemini yapmadan önce ortak fieldların eşleşme durumunu, 
veritabanlarını kolaylıkla kontrol edebilirisiniz.  Verilerin eşleştiğinden emin olduktan sonra OK 
butonuna tıklayınız.  

     

8. Nufus2000 tablosu Turkiye_il katmanına geçici olarak eklenmiştir. Aynı şekilde Turkiye_Secim95 
ve Turkiye_Saglik tablolarını da join ile ekleyiniz. 
 

 
 
 

9. Layer Properties ekranında OK butonuna tıklayınız. Identify aracıyla yeniden Eskişehir ilinin 
üzerine gelip tıklayınız. Saklanan pencere olarak ayarladığınız Identify penceresi ekranın sağında 
tekrar açılacaktır. Identify Result penceresinde daha çok kaydın eklenmiş olarak geldiğini 
göreceksiniz. 
 



 
 

Adım 2 : Symbology  
 

1. Table of Contents’de 2000 yılına ait nüfus verileri 1995 yılına ait seçim verileri ve sağlık verileri 
eklendikten sonra menü görüntüsünü tekrar List By Drawing Order olarak değiştiriniz. Bunun 

için Table of Contents’de  simgesini tıklayınız. 
2. Turkiye_il katmanında bulunan illerin hepsi şu anda tek bir sembol ile gösterilmektedir. Join ile 

eklenilen Nüfus 2000 değerine göre tematik harita oluşturmak için katman üzerinde sağ tıklayıp 
Layer Properties penceresini açınız. Symbology sekmesini seçiniz. 

3. Sayısal öznitelik değerlerine göre tematik harita oluşturmak için Quantities’i tıklayınız ve 
Graduated Colors özelliğini seçiniz. Value Field olarak NUFUS_2000 özniteliğini seçiniz.  

 



4. İl sınırları 2000 yılı nüfusuna göre belirtilen renk aralığında 5 sınıfta dereceli olarak 
renklendirilmiştır. (İsteğe göre Classification özelliğinden sınıf sayısını arttırabilir veya 
azaltabilirsiniz). Range ve Label seçeneklerinde ise mouse ile tıkladığınız zaman bu değer 
aralıkları içinde istediğiniz şekilde değişiklik yapabilirsiniz. Label bölümünde yapılacak değişiklik 
haritanızı çıktıya hazırlarken(layout) Lejant olarak gösterileceği için harita çıktısı görselliği 
açısından aşağıdaki gibi ayarlayınız. 
 

 
 

5. OK’e tıklayınız. Turkiye Nüfus Dağılım haritası oluşturulmuştur. 

 
 

6. Insert menüsünden Data Frame seçeneğini  tıklayınız. Veritabanına join 
edilmiş şekilde veriler Turkiye_il katmanında bulunduğundan dolayı bu katman üzerinde sağ 
tıklayarak Copy butonunu seçiniz ve yeni oluşturduğunuz New Data Frame üzerinde sağ 
tıklayarak Paste Layer’a tıklayınız. 
 

       
 



7. Yeni veri çerçevesine kopyalanan Turkiye_il katmanında Kişi başına düşen Hekim sayısı tematik 
olarak gösterilecektir. Bunun için katman üzerinde sağ tıklayarak Layer Properties’i açınız ve 
Symbology sekmesini seçiniz. 
 

 
 

8. Quantites > Graduated Colors özelliğini seçiniz. Value Field olarak HEKIM özniteliğini, 
Normalization olarak da NUFUS_2000 özniteliğini ayarlayınız. OK’i tıklayınız. Böylelikle Nüfusa 
göre Hekim sayısını gösteren ilk tematik haritanızı elde etmiş olacaksınız. 

 

 
 

Farklı Data Frame’ler üzerinde çalışmak, aynı çıktı sayfasında birden fazla harita oluşturmaya 
yardımcı olur. Başka çalışma alanı üzerinde çalışmak istendiği zaman başka bir ArcMap arayüzü 
açmak yerine Data Frame’ler eklenerek tek ArcMap arayüzü üzerinde birden fazla harita 
görüntülemesi yapılabilir. Data Frame’ler arası geçiş Active butonu ile sağlanır. Hangi veri 
çerçevesi Data View ekranında görüntülenmek isteniyorsa o Data Frame üzerinde sağ tıklanarak 
Activate seçilir.  
 



 
 

9. Aktif yaptığınız Data Frame üzerinde sağ tıklayarak Properties’i seçerek Data Frame Properties 
penceresini açınız. General sekmesini seçiniz ve Name kısmına “Nüfus” yazınız. OK’i tıklamadan 
önce veri çerçevesi olarak hangi özelliklerin bulunduğunu inceleyiniz. Örneğin, Nüfus veri 
çerçevesi Decimal Degrees biriminde görüntülenmektedir. OK’e tıklayınız. 
 

           
 

10. Aynı şekilde New Data Frame üzerinde sağ tıklayarak Properties’i seçiniz ve General 
sekmesinden Name kısmına “Sağlık” yazınız. OK’i tıklayınız. Sağlık veri çerçevesi üzerinde sağ 
tıklayarak Activate seçiniz. Böylece Sağlık veri çerçevesi aktif olur ve bu veri çerçevesi altında 
bulunan harita veya haritalar Data View ekranında görüntülenir. 



      
 

11. Insert > Data Frame seçerek “New Data Frame 2” adında yeni bir veri çerçevesi ekleyiniz. 
Yukarıdaki Nüfus ve Sağlık veri çerçevelerinden herhangi birinde bulunan Turkiye_il katmanı 
New Data Frame 2’ye kopyalayıp yapıştırınız. (İpucu: Bu işlem Sağlık veri çerçevesini oluşturmak 
için yapılmıştı.) 

12. Kopyalanan Turkiye_il katmanı üzerinde sağ tıklayarak Propeties’i seçiniz. Açılan Layer 
Properties penceresinde Symbology sekmesinde Charts > Pie kısmına tıklayınız. Field Selection 
kısmında Turkiye_il katmanı öznitelik fieldları görüntülenmektedir. Burada seçeceğiniz partileri 
“>” simgesini tıklayarak sağındaki kutucuğa taşıyınız. Böylece seçilen partilerin oy dağılımları 
Pasta Dilimi sembolüyle ekranda görüntülenecektir.  

 
 



13. Aynı ekranda Size butonuna tıklayınız. Tüm pasta dilimi sembolleri aynı boyutta (32pt) 
görüntülenmektedir. Fakat seçmen sayısına göre bu sembollerin de büyüklüğünü değiştirmek 
için Vary Size using a field olarak SECSAY field’ını seçiniz. OK’i tıklayınız. 
 

 
 

14. Layer Properties ekranında OK’i tıklayınız. Bu veri çerçevesinin adını “Seçim” olarak değiştiriniz. 
(İpucu: Nüfus ve Sağlık veri çerçevelerinin adlarını değiştirmek için yapılmıştı.) 

15. Insert > Data Frame seçerek “New Data Frame 3” adında yeni bir veri çerçevesi oluşturunuz. 
Turkiye_il katmanını tekrar bu veri çerçevesine kopyalayıp yapıştırınız. Yapıştırdığınız Turkiye_il 
katmanın Layer Properties penceresini açarak Symbology sekmesini tıklayınız. 
 

16. Quantities > Graduated symbols kısmını seçiniz. Nüfusa göre değişen semboller ile tematik 
gösterim için bu seçim yapılmıştır. Value Field olarak NUFUS_2000 özniteliğini seçiniz. OK’i 
tıklayınız. 
 

 



17. New Data Frame 3 olan veri çerçevesinin adını “Nüfus2” olarak değiştiriniz. 
 

 
  
 Table of Contents’de 4 farklı veri çerçevesi ve 4 farklı harita oluşturulmuştur. Bu haritalar bir 
sonraki uygulamada çıktıya(Layosut) hazırlanacaktır.  
 

18. File > Save As tıklayarak projeyi C:/ArcGIS10_EGITIM/Uygulama04/Layout.mxd olarak 
kaydediniz. ArcMap’i kapatınız. 
 
 

Uygulama 4 :  
 
Haritaların Kartografik Üretimi, Çıktı(Layout); 

 
Bu uygulamada, bir önceki uygulamada 4 farklı veri çerçevesinde hazırlamış olduğunuz haritalardan, 
Coğrafi Bilgi Sistemlerinin  genel işlevleri arasında bulunan çıktıya hazırlama fonksiyonu uygulaması 
yapılacaktır. Data View ekranında hazırlanan haritaların, tanımlanan semboloji ve etiket bilgileriyle 
birlikte ölçek değerlerine göre çıktıya hazırlanması ve kağıt haritalar şeklinde çıktı olarak kullanılması 
işlemine Layout denilmektedir. ArcGIS’de bu işlem için Layout View ekranı kullanılmaktadır. 
 

1. Başlat > Tüm programlar > ArcGIS > ArcMap 10 tıklayınız ve bir önceki uygulamada 
hazırladığınız Layout.mxd projesini açınız. (İpucu: C:/ArcGIS10_EGITIM/Uygulama04/Layout.mxd 
kaydedilmişti.) 

 
 

2. Layout.mxd 4 farklı veri çerçevesinde oluşturulmuş haritalar içermektedir. Sembolojilerini 
değiştirdiğimiz bu haritaları Data View ekranında veri çerçevelerini aktif ederek teker teker 
görüntüleyebilmekteyiz. Çıktıya hazırlamak için kullanacağımız ekran olan Layout View ekranına 
geçmek için menülerden View > Layout View seçeneğine tıklayınız. Ya da kısayol olarak ArcMap 
arayüzünün altındaki Data View ve Layout View ekranları arasında geçişi sağlayan simgelerden 

Layout View  aracına tıklayınız. 
 



                             
 

3. Açılan sayfada, oluşturulan tüm veri çerçeveleri içinde bulunan haritalar ekranda üst üste 
gelirler. Haritaların, çıktıya hazırlamak istediğimiz şekilde sayfa boyutu içine sığdırılması 
gerekmektedir. Bunun için önce sayfa ve printer ayarları yapılmalıdır. File > Page and Print 
Setup’ı seçiniz. Açılan pencerede Use Printer Page Settings seçeneğine ait tiki kaldırınız ve hangi 
sayfa boyutunda çıktı hazırlanılması isteniyorsa ona ait ayarlamarı yapınız. Orientation 
seçeneğini Landscape yaparak sayfanın yatay durmasını sağlayınız. OK’e tıklayınız. 

       
 

4. Hangi veri çerçevesine ait harita üzerinde işlem yapılmak isteniyorsa, o çerçeveyi (Lejant, ölçek, 

başlık ekleme vs) Select Elements  ile üzerinde bir kez tıklayarak seçili duruma getiriniz. Seçili 
olan veri çerçevesi hangisi ise Table of Contents’de koyu renkli olacak şekilde aktif olur. Nüfus, 
Seçim, Sağlık ve Nüfus2 haritalarını sayfa içerisine yerleştiriniz. 
 



 
 

5. Layout View’da seçili olan veri çerçevesi Table of Contents’de Koyu harflerle belirtilen Seçim’dir. 
Çıktıya eklenecek olan harita objeleri (Kuzey Oku, Lejant, Ölçek vb.)  hangi veri çerçevesindeki 
haritaya eklenecekse şekildeki gibi seçili olmalıdır. Şekilde Seçim veri çerçevesi aktif durumdadır 
ve bu veri çerçevesine ait çıktı objeleri eklenecektir.  
Çıktı işlemi için kullanılacak objeler (Kuzey Oku, Lejant, Ölçek vb.) Insert menüsünden eklenir. Bu 
menü çıktı objelerini eklemeyi sağladığından dolayı sadece Layout View ekranında aktif olarak 
kullanılmaktadır. 

6. Insert > Title seçiniz. Bu işlem çıktıya hazırlanacak haritaya başlık eklemeyi sağlar. 
Insert > North Arrow seçiniz. Açılan pencerede Kuzey oklarının bulunduğu sembol kütüphanesi 
gelir.Kullanmak istediğiniz kuzey okunu seçiniz ve sonra veri çerçevesi üzerinde uygun bir yere 

yerleştiriniz. İsteğe göre kuzey oku grafiği üzerinde Select Elements  ile çift tıklayarak açı, yön 
gibi değişiklikler yapabilirsiniz. 

     



Insert > Scale Bar seçeneğine tıklayınız. Seçili olan veri çerçevenizin Layout View ekranında 
görüntülenen ölçeğine göre çizgisel ölçek oluşturacak sembolojiler ekrana gelmektedir. 
İstediğiniz çizgisel ölçek sembolünü seçiniz. Ölçeğin birimi veri çerçevesinin birimi olarak 

gelecektir; değiştirmek için Select Element  ile çift tıklayınız ve Divisions Units kısmından 
Kilometre olarak değiştiriniz.     
 

     
 

Lejant eklemek için Insert > Legend seçeneğine tıklayınız. Açılan pencerede lejant olarak hangi 
katmanların görüntülenmesini istediğinizi seçiniz. Aşağıdaki şekildeki gibi ayarlamalar yapınız ve 
Finish’i tıklayınız. 
 

         
 
 



                   
 

Oluşan lejant üzerinde grafiksel bazlı obje değişiklikleri yapmak için lejant üzerinde sağ tıklayarak 
Convert to Graphics fonksiyonunu seçiniz. Daha sonra Ungroup seçeneğiyle değişiklikler 
yapılabilmektedir.  
 

7. Her bir veri çerçevesi için bu düzenlemeleri teker teker ayarlayınız. Haritalara temel çıktı 
objelerini tanımlayınız. 
 

 
 

8. Insert > Dynamic Text > Coordinate System seçeneğine yıklayınız. Bu işlem veri çerçevelerinin 
tanımlanan koordinat sistemini bilgi olarak çıktı sayfasına ekler. Uygulamada bulunan 4 veri 
çerçevesinin de koordinat sistemleri aynı olduğundan bir tane tanımlanması yeterli olacaktır. 



Insert > Dynamic Text > Author seçeneğine tıklayınız. Bu işlem ile haritayı hazırlayan kişi veya 
kurumları otomatik olarak ekleyebilirsiniz. 
Insert > Dynamic Text > Current Date seçeneği ile de haritanın hazırlandığı tarihi sayfaya 
ekleyiniz. 
 

 
 

9. Haritanın çıktıya hazırlığı tamamlandıktan sonra farklı formatlarda kaydetmek için File > Export 
Map seçeneğine tıklayınız Layout.jpeg dosyası olarak Masaüstünüze kaydediniz. ArcMap’i Save 
ederek kapatınız. 
 

Uygulama 5 :  
 
Semboloji Kütüphanesi (Style); 

ArcGIS Teknolojisi (ArcView,ArcEditor ve ArcInfo için) kullanıcılarına geniş bir semboloji kütüphanesi 
sunmaktadır.Semboloji kütüphanesi ArcGIS içerisinde Style olarak adlandırılır. ArcMap arayüzünde 
nokta, çizgi, tarama, renk, ölçek çubuğu, kuzey oku, çerçeveler, yazı tipleri gibi özellikler ve bu özellikleri 
içeren çok sayıda farklı semboloji bir kütüphane içerisinde depolanır ve ArcGIS teknolojisi sayesinde 
program içerisinde kullanımı sağlanır . 

Yeni bir semboloji kütüphanesi tanımlandıktan sonra ArcMap arayüzünde yer alan araçlar yardımı ile 
semboller oluşturulur.Semboloji kütüphanesi yardımı ile yeni sembollerin oluşturulması,sembollere 
verilen isimlerle, herhangi bir katmanın veritabanında yer alan belli öznitelikleri eşleştirilerek ,istenilen 
özniteliğe göre semboloji atanması işlemi otomatik olarak gerçekleştirilmiş olur. 



 
 

       
 
                                  

1. ArcGIS10_Egitim/Uygulama_05 dosyasında yer alan Uygulama_05.mxd’yi ArcMap  arayüzünde 
açınız. 
 

 
 

2. Menu Bar’dan Customize>Style Manager fonksiyonuna geçiniz 
 

Style Manager Penceresinden, sistemde halihazırda yer alan kütüphaneleri görebilir veya daha önceden 
kullanıcılar tarafından çeşitli amaçlarla  oluşturulmuş olan kütüphaneler yardımıyla yeni bir kütüphane 
dosyası oluşturabilirsiniz.Çalıştığınız kurum ya da kuruluşun kendine ait logo,sembol veya tasarımlarını 
bu şekilde ArcGIS semboloji kütüphanesine ekleyebilir ve amaçlar doğrultusunda kullanabilirsiniz. 

  



Bu uygulamada, öncelikle Jeoloji.style dosyasının Formasyon katmanının veri tabanındaki Açıklama 
field’ına göre otomatik olarak eşleşmesi sağlanacak, daha sonra kullanıcıların kendi sembollerini nasıl 
oluşturacakları gösterilecektir.  

 
 

3. Style Manager Penceresinden Styles butonuna basınız. Açılan Style References penceresindeki 
Add Style to List seçeneğine tıklayınız ve daha önceden hazırlanan  Uygulama_05/Style 
klasöründe yer alan Jeoloji.style dosyasını seçiniz ve OK butonuna tıklayınız.  
 

 
 

4. Add Style to List işleminden sonra Style Manager penceresinde yer alan Jeoloji.style 
kütüphanesindeki Fill, Line ve Marker  Symbol’leri inceleyelim. 



 

 

 

5. Style Manager’daki Jeoloji.style kütüphanesindeki Fill Symbol’ü mouse ile seçiniz.Sembollerin 
yer aldığı alanda mouse’un sağ tuşuna basarak New>Fill Symbol özelliğini seçiniz. 
 

 



6. Ekranda açılan Symbol Property Editor size  Jeoloji.style kütüphanesinde yeni bir tarama 
sembolojisi oluşturmak için imkan tanırken aynı zamanda yine buradan, bilgisayar içerisindeki 
resim tipi bitmap olan bir dosyayı Jeoloji.style kütüphanesine eklemeyi de sağlamaktadır. 
Bilgisayarınızdan bir sembol eklemek için yapmanız gereken;  Type’ı Picture Fill Symbol olarak 
ayarlayıp,bilgisayar içerisinden (C:\ArcGIS10_Egitim\Uygulama_05\Style\sembol.bmp) ilgili 
resim dosyasını seçmektir. Daha sonra Symbol Property Editor’de resmin üzerinde istenilen 
değişiklikler yapılabilir. Bilgisayarınızdan bitmap resim dosyasını seçip Open butonuna basınız ve 
daha sonra OK’e tıklayınız.  

 

      
 

7. Oluşan sembolün adını Bazalt olarak ayarlayınız.  
Uygulamanın başında ArcMap arayüzünde,  Style Kütüphanesinden yararlanarak otomatik olarak 
sembollerin eşleştirilebileceğinden bahsetmiştik. Bu işlemin gerçekleşebilmesi için Style 
dosyasındaki sembollerin isimleri ile katmanın ilgili öznitelik sütününda yazan ifadeler birebir 
aynı olmalıdır. 
 

8. Şimdi de ESRI.style kütüphanesinde tanımlanmış bir çizgi sembolü olan Railroad’u seçip 
mouse’un sağ tuşuna basarak Copy fonksiyonuyla kopyalayınız. Style Manager’da  Jeoloji Style 
kütüphanesine geçerek Line Symbol içerisine  Paste fonksiyonu ile yapıştırınız. Sembolün adını 
Demir Yolu olarak (rename) yeniden adlandırınız.  



 

       

9. Close butonuna tıklayarak Style Manager penceresini kapatınız.  
 

10. Jeolojik Formasyonlar katmanına ait Layer Properties menüsünde Symbology sekmesine 
tıklayınız.Bu sekmede; Value Field ACIKLAMA olacak şekilde Match to Symbols in Style 
kısmından Jeoloji.style dosyasını seçip Match Symbols tuşuna basıp OK’i tıklayınız.  
 

 
 
Bu işlem ile Jeoloji.style dosyasında oluşturulmuş olan semboller Formasyon katmanının 
açıklamaları ile eşleşerek olması gereken sembolojiyi kazanmış oldu.  
 



 
 

11. Aynı işlemleri Table Of Contents’deki Yollar Katmanı için yapalım. Yollar Katmanına ait Layer 
Properties’den Symbology sekmesine geçiniz.Categories altında yer alan Match to symbols in a 
Style fonksiyonunu ayarlayınız. Value Field’a, Aciklama, Match to symbols in Style’a, 
Jeoloji.style kütüphanesini ayarlayınız. Sonra da OK tuşuna basarak işlemi sonlandırınız. Böylece 
Style dosyasındaki semboller, katmanın Aciklama sütünundaki isimlerle eşleştirilerek otomatik 
olarak atanmış olacaktır. 

 

 
 



12. Tabaka Doğrultu Katmanına ait Layer Properties menüsünde Symbology sekmesine geçiniz. 
Feaures altında Single Symbol fonksiyonunu ayarlayınız.  Symbol Selector penceresinden Tabaka 
Doğrultu sembolünü seçiniz ve OK butonuna tıklayınız.  
 

 
 
 

13. Advanced butonundan Rotation fonksiyonunu seçiniz ve Rotation Field’ı Doğrultu olarak 
ayarlayınız.Açık olan her iki pencerede de OK butonuna tıklayınız.       
 

   

                                                                                             
14. Bu işlem ile tabaka doğrultu sembolleri veri tabanında bulunan açı değerlerine göre 

döndürülmüş olmaktadır. 
15. Projeyi kaydediniz ve ArcMap’den çıkınız. 

           



Uygulama 6: 

Coğrafi Verilerin Sorgulanması; 
 
Select Features, Select By Attribute, Select By Location, Select By Graphics; 

Coğrafi Bilgi Sistemlerinde grafik ve grafik olmayan verilerin birbirleri ile bütünleşik olarak sorgulanması 
mümkündür. Böylece grafik verilerden sözel verilere, sözel verilerden grafik (konumsal) verilere hızlı 
erişim imkanınız olur. 
 
Önceki uygulamalarımızda Grafik verilerin veritabanına göz atmak istediğimizde Tools Toolbar’dan 
identify aracını kullanmıştık. Benzer şekilde veri tabanı bilgilerinden Grafik veriye hızlı erişimi Main Menu 
Bar’da yer alan Find fonksiyonu ile gerçekleştirmiştik. Diğer bir deyişle Find fonksiyonu text veriden 
grafik veriye ulaşmamızı sağlamıştı. 
 
Bu bölümde ArcMap arayüzünde programın bize grafik seçmek için sağladığı araçların (Select by 
rectangle, polygon, lasso, circle, line) kullanılması, Görüntülenen Grafik verilerin veri tabanındaki 
öznitelikleri (attributes) üzerinden mantıksal sorgulamalar yaparak Grafik veriye ulaşması (Select By 
Attributes) ve farklı coğrafi verilerin birbirleriyle mekansal ilişkilerinin sorgulanması (Select By Location) 
gibi  konular üzerinde duracak ve uygulamalar yapacağız. 

1. ArcGIS10_Egitim klasöründe yer alan Uygulama_06.mxd dosyasını ArcMap ortamında açınız 
 

 
 

2. Türkiye Maden Yatakları Data Frame’inde yer alan ILLER katmanını Identify  aracıyla 

inceleyiniz. 

 



 

  Find aracı sayesinde öznitelik bilgilerinden (Attributes) herhangi birini bildiğiniz bir grafik 
veriye ulaşabilirsiniz. Örneğin: Çorum ilini bulmak istiyorsunuz… 

3. Veritabanındaki metinsel(text) ifadelerden ekrandaki grafik veriye ulaşmanızı sağlayan  Find 
aracı üzerine tıklayınız. Features sekmesinde Find kutucuğuna Çorum ifadesini yazıp Find 
butonuna tıklayıınız. Arama sonuçları içerisinde Çorum yazan yere çift tıkladığınızda ekrandaki 
görüntü  otomatik olarak Çorum üzerine gidecek ve flash görüntü ile yerini belirtecektir.  
 

 
 

4. Sonuç üzerinde mouse’un sağ tuşuna basıp Select seçeneğine bastığınızda ise Çorum ili seçilmiş 
olacaktır. 
 

 
 

ArcGIS 10’da geliştirilen Tools Toolbar’daki Select Features By seçeneği size farklı sekillerde 
grafik seçim imkanları sunmaktadır. 
 
Select by Rectangle: Oluşturduğunuz diktörtgenle grafik veri seçmenizi sağlar. 
Select by Polygon   : Oluşturduğunuz alanı dikkate alarak grafik veri seçmenizi sağlar. 



Select by Lasso        : Oluşturduğunuz kement şekline göre grafik veri seçmenizi sağlar. 
Select by Circle        : Oluşturduğunuz çember şekline göre grafik veri seçmenizi sağlar. 
Select by Line           : Oluşturduğunuz çizgi şekline göre grafik veri seçmenizi sağlar. 

 

 
 
Bu seçenekleri kullanırken seçim yapacağımız katmanı Selectable Layer(seçilebilir katman) 
yapmamız daha uygun olacaktır. Sadece bir grafik veri seçmek için Select by Rectangle,Lasso 
veya Circle seçeneklerinden birini seçip grafik veri üzerinde mouse ile tıklamanız yeterli 
olacaktır.Bu araçlar size daha hızlı seçim imkanı sağlamak amacıyla tasarlanmıştır. 
 

5. Katman seçilebilirliğini ayarlamak için Table of Contents’de List By Selection  sekmesine 
tıklayınız.  

6. Listede ILLER katmanında Click to toggle selectable butonuna tıklayarak İller katmanının 
seçilemez olmasını sağlayınız.  

                                  

7. Katmanı tekrar seçilebilir olarak ayarlamak için Not Selectable kısmında tekrar Click to toggle 
selectable butonuna tıklayınız.  
 
Bu aşamaya kadar ekran üzerinde seçim araçlarını inceledik.  Şimdiki uygulamamızda Türkiye 
Maden Yatakları Data Frame’i üzerinden bazı sorgulamalar yapacağız.Haritadaki iller maden 
çıkan noktalarını sayısına göre açık renkten koyu renge doğru sembolize edilmiştir.Amacımız, 
sınırları içerisinde maden çıkan noktaların sayısı belirli olan illerden, belirtilen sayıda noktaya 
sahip olanlar içerisinden metalik maden içerenlerin sayısını bulmaktır. 
 
Soru: Maden_Çıkan_Nokta sayısı 8’den fazla olan illerden, il sınırları içerisinde Metalik Maden 
bulunduranların sayısı kaçtır? 



 
 

 

 
8. Main Menu Bar’da Selection menüsünden  Select By Attributes  seçeneğini seçiniz. 

 

  
                   

9. Açılan pencerede Layer kısmını ILLER katmanı, Method’u  Create a new selection olacak şekilde 
ayarlayınız. Üsteki pencerede katmana ait field isimleri listelenmektedir. Listeden  
Maden_Cıkan_Nokta seçeneğine çift tıklayarak bu field isminin alttaki komut satırına gelmesini 
sağlayınız.  

10. Alt pencereye “> 8” yazınız. Komut satırındaki ifadenin şekildeki  gibi olduğundan emin olduktan 
sonra OK butonuna tıklayınız.  
 



 
 
Bu işlem ile 8 noktadan fazla noktada madencilik faaliyetleri yürütülen iller şeçilmiş olacaktır.  

 

 
 

11. Bu iller içerisindeki Madenleri bulmak için Selection menüsünden Select by Location seçeneğine 
tıklayınız. 
 

 



12. Açılan pencerede Source layer’ı ILLER, Spatial selection method’u ‘Target Layer(s) features 
intersect the Source layer feature’, Target layer(s)’ı ise  MADEN olarak ayarlayınız. OK 
butonuna tıkladıktan sonra seçili olan  ILLER katmanı içerisine giren bütün MADEN’leri 
bulacaktır. Metalik Madenleri bulmak için sorgulamaya devam ediyoruz. 
 

 
 

13. Main Menu Bar’da Selection menüsünden tekrar Select By Attributes  seçeneğini seçiniz. 
14.  Layer kısmını MADEN, Method’u select from current selection olarak ayarlayınız. Üstteki 

listeden TUR ismine çift tıklayarak aşağıdaki komut satırına gelmesini sağlayınız. Tür fieldı 
içerisindeki kayıtları listelemek için Get Unique Values butonuna tıklayınız. Daha sonra listeden 
Metalik Madenleri seçip çift tıklayınız. Komut satırına geldiğine emin olduktan sonra OK 
butonuna tıklayınız.  

 



Table Of Contents’de List By Selection  sekmesini  kontrol ettiğimizde Sonuç olarak ILLER 
katmanından 17 il içerisinde, MADEN katmanından 99 tane seçili Metalik Maden olduğunu 
göreceksiniz. 
 

    

15. Şimdi yeni bir uygulama yapmak üzere Ankara Data Frame’ini aktif hale getirelim.  
 

 
 
Soru: Alper Sokak’ın 500 m etki bandında bulunan binalardan taban alanı 500 m2’den büyük 
olanları bulunuz.  
 

16. Bu soruyu çözmek için öncelikle Alper Sokak’ın bulunması gerekmektedir. Selection 
menüsünden Select By Attributes seçeneğine tıklayınız.     

17. Layer kısmını Yol_Orta katmanı, Method’u: Create a new selection olarak ayarlaynız. AD fieldı 
üzerinde çift tıklayarak komut satırına gelmesini sağladıktan sonra AD field’ı içerisindeki kayıtları 
görüntülemek için Get Unique Values butonuna tıklayınız. Komut Satırında “AD” = ‘Alper Sokak’ 
yazdığına emin olduktan sonra OK butonuna tıklayınız.  
 



      
 

18. Alper Sokak’ın 50 m etki bandındaki binaları bulmak için Selection Menüsünden Select by 
Location seçeneğine tıklayınız.          

19. Ayarları şekildeki gibi yaptıktan sonra OK butonuna tıklayınız.   
 

 
 



20. Bu aşamada Alper Sokak’ın 50 m etki bandında kalan bütün binalar seçilmiş olacaktır. Bu 
binaların içerisinden taban alanı 500 m2’den büyük olanları bulabilmek için tekrar Select By 
Attributes seçeneğini tıklayınız.   

21. Select By Attributes penceresinde ayarları şekildeki gibi yapınız. 
 

 

 

Sonuç olarak Yol_Orta katmanından 1, Binalar katmanından (Kapı_No:37) 1 grafik veri seçilmiş olacaktır.  
 

               

Şimdi yapıcağımız örneklerde ArcGIS’de Rapor hazırlama ve grafik oluşturma fonksiyonları üzerinde 
duracağız. 



Rapor Oluşturma: 

 
Bu örnekte ArcGIS’in rapor hazırlama özelliğine örnek vereceğiz.  
Ankara Data Frame’inde  Sokak Adlarını ve onlara ait uzunlukları gösteren bir rapor hazırlayacağız.Rapor 
hazırlama özelliği ArcGIS’de size rapor hazırlama sihirbazının sağladığı imkanlarla çok kolay ve çok kısa 
süre içerisinde gerçekleştirilebilmektedir. 
 

22.   Main Menur Bar’dan View>Reports>Create Report seçeneklerini sırası ile seçiniz 
 

 
 

23. Açılan pencereden “AD” ve “Shape_Length (uzunluk)” Field’larını seçip sağ yönü gösteren oka 
tıklayınız. 

 

 



 

 
 

24. Sırası ile  Next > Next dedikten sonra gelen pencerede Raporda Göstermek istediğimiz Fieldların 
adını yani AD ve Shape_Lenght fieldlarını aşağıdaki gibi seçiniz. 
 

 
 
 

 



25. Tekrar Next butonuna basarak pencerenin sağ üst köşesinden raporun yatay (horizontal) veya 
dikey (Portrait) olma durumunu ayarlayınız.Bu örnek için Portrait seçeneğini seçiniz. 
 

 
 
 

26. Tekrar Next butonuna basınız ve Havelock style’ı seçip  Next butonuna basınız ve Rapor için 
başlık belirleyiniz.Bu örnek için başlığa Sokak İsimleri ve Uzunlukları yazınız. 
 

 



27. Raporu görüntülemek için Finish butonuna tıklayınız ve raporu görüntüleyiniz. 
 

 
 
 

Grafik Oluşturma: 
 
Bu örnekte ArcGIS’in grafik  hazırlama özelliğine örnek vereceğiz. 
Maden Yatakları Data Frame’inde  İl isimlerini ve o illerdeki maden çıkan nokta sayısını gösteren  
bir grafik  hazırlayacağız. Grafik hazırlama özelliği rapor hazırlamada olduğu gibi ArcGIS’de 
sihirbazın sağladığı imkanlarla çok kolay ve çok kısa süre içerisinde gerçekleştirilebilmektedir. 
 

28. Graph Wizard’da aşağıdaki ekran kopyasında olduğu gibi Layer/Table kısmına ILLER katmanını X 
Label Field’a AD sütün ismini seçili hale getiriniz ve Next butonuna tıklayınız. 
 



 
 

29. Penceredeki Title kısmına Maden Cikan Nokta Grafigi yazınız,Graph in 3D view seçeneğini 
işaretliyerek grafiği 3 boyutlu görünüme kavuşturunuz ve Finish butonuna basarak işlemi 
sonlandırınız.  
 

 



30.  Grafiğiniz ekranda aşağıdaki şekilde gözükecektir. 
 

  
 

31. Uygulama_06.mxd’yi kaydedip ArcMap’den çıkınız. 

 

Uygulama 7 :  
 
Raster Haritaların Coğrafi Olarak Koordinatlandırılması (Georeferencing); 
 
Taranmış raster verilerin gerçek dünya yüzeyi üzerindeki koordinatlarına tam oturması için yapılan 
işleme coğrafi koordinatlandırma(georeferencing) denilmektedir. Bu işlemi yaparken raster üzerindeki 
koordinatları bilinen noktaların arayüzde eşleşmesi sağlanır. İşlem sonunda koordinatı eşleşecek 
noktanın seçim hassasiyeti, paftanın tarayıcıdaki tarama hassasiyetine kadar birçok etkene göre 
RMS(karekök) hatası belirlenir. Bu hata belli bir standard sapma değerinin içinde kabul edilebilir ama bu 
değerin üzerindeyse işlemin tekrarı gerekmektedir. 
 

1. C:/ArcGIS10_EGITIM/Uygulama07/Uygulama_07.mxd’yi çift tıklayarak ArcMap 10’da açınız. 
 

 
 

2. Customize > Toolbars > Georefencing tıklayınız. Raster verilerin koordinatlandırılması için 
Georeferencing araç çubuğu kullanılmaktadır.  
  



  
3. Table of Contents’de tek bir raster veri bulunduğundan dolayı Layer seçeneği otomatik olarak 

f22d22d3c.tif dosyasını seçili olarak getirmiştir. Fakat birden fazla raster bulunursa hangi raster 
üzerinde georeferencing işlemi yapılması isteniyosa ilk olarak Layer’dan o raster’ın seçilmesi 
gerekmektedir. 
 

4. Georeferencing menüsünün altındaki Auto Adjust’ın tikini kaldırınız. 
 

5. f22d22d3c.tif rasterının sol üst köşesine doğru Zoom In aracıyla  yakınlaşınız. Raster 
üzerinde bu köşeye ait koordinatlar yazmaktadır. Georeferencing araç çubuğunda bulunan Add 

Control Points  aracını seçerek sol köşe noktasında aşağıdaki görüntüde olduğu gibi 
mouse’un sol tuşuna bir kere tıklayınız. Gerçek koordinat değerlerini girebilmek için mouse’un 
sağ tuşuna bir kere tıklayarak Input X and Y seçeneğini tıklayınız. Açılan pencereye pafta 
üzerinden okuduğunuz X ve Y koordinatlarını aşağıdaki gibi yazınız. 
 

   
 
6. İlk noktaya ait değeri girdikten sonra ikici köşe olarak paftanın sağ üst köşesine yakınlaşınız. 

Georeferencing araç çubuğundaki Add Control Points aracıyla sağ üst köşeye mouse’un sol 
tuşuna bir kere ve ardından sağ tuşuna bir kere tıklayarak aşağıdaki X ve Y koordinat değerlerini 
yazınız. OK’i tıklayınız. 
 



   
 

7. Aynı yöntemlerle paftanın sağ alt köşe ve sol alt köşe koordinat değerlerini aşağıdaki gibi 
tanımlayınız. 
 

 
                        Sağ Alt Köşe               Sol Alt Köşe 
 

8. Tüm noktalara ait koordinat değerlerini yazdıktan sonra Georeferencing araç çubuğundaki View 

Link Table aracını  tıklayınız. Açılan Link Table penceresinden yanlış yazılan X ve Y 
koordinatlarını Xmap ve Ymap seçeneklerinden düzeltebilirsiniz. Daha sonra pencerenin sol 
altında bulunan Auto Adjust’ın tikini atınız. OK’i tıklayınız. 

 



9. Raster veri girilen gerçek koordinat değerlerine taşındığı için ekrandaki görüntüden 

kaybolmuştur. Full Extent  butonuna tıklayarak rasterı ekrana getiriniz. Mouse’unuzu hareket 
ettirdiğiniz sağ alt ekranda görüntülenen koordinat değerlerinin değiştiğini göreceksiniz.  
 
Yapılan değişikliklerin farklı bir raster veri olarak kaydedilmesi gerekmektedir.   
 

10. Bunun için Georeferencing araç çubuğunda Georeferencing > Rectify’ı tıklayınız. Ayarları 
aşağıdaki gibi yaparak Save butonuna basarak işlemi tamamlayınız.   
 

                    
 

Rektifiye edilen raster veriye projeksiyon sistemi tanımlanmalıdır. ArcMap arayüzü içerisinde 
saklanabilir pencere olarak gelen ArcCatalog ile verilere projeksiyon sistemi 
tanımlanabilmektedir. 
 

 



11. Catalog penceresini açmak için Standard araç çubuğu üzerinde Catalog Window simgesini 
tıklayınız. 
 

12. Catalog penceresinde REC_f22d22d3c.tif dosyası üzerinde sağ tıklayarak Properties’i seçiniz. 
Açılan Raster Dataset Properties penceresinde Spatial Reference seçeneği herhangi bir 
projeksiyon sistemi henüz tanımlı olmadığından dolayı <Undefined> olarak gelir. Yanındaki 
“Edit” seçeneğine tıklayınız.  

   
 

13. Açılan Spatial Reference Properties penceresinde aynı yere ait daha önceden koordinat sistemi 
tanımlanan bir katmanın koordinat sistemi eklemek için Import’u seçiniz.  
C:/ArcGIS10_EGITIM/Uygulama_08/F22d22d3c_Pafta.shp katmanını seçerek Add butınuna 
tıklayınız. 

 



14. Spatial Reference Properties penceresinde OK’i tıklayınız. Raster Dataset Properties 
penceresine koordinat ve projeksiyon sistemleri bilgileri gelmektedir. 

 

        
 
15. Raster Properties ekranında OK’i tıklayınız. REC_f22d22d3c.tif raster’ı coğrafi olarak 

koordinatlandırılmış olarak kullanılabilir. ArcMap’i kaydetmeden kapatınız. 

 

Uygulama 8 :  

Catalog’da Veritabanı Tasarımı; 

ArcCatalog, ESRI’nin vektör ve raster verilerinin tasarlanıp yönetildiği arayüz uygulamasıdır. ArcGIS 
Desktop yazılımı içerisinde gelen bu arayüz ArcGIS 10’dan itibaren ArcMap arayüzü içerisinde ayrı bir 
pencere olarak da gelmektedir.  ArcCatalog ile şunları yapabilirsiniz; 

• ArcGIS veri formatlarının oluşturulması (Geodatabase Feature Class, Raster Dataset ve Shapefile) 

• Veri tabanı tasarımı olarak Field’ların oluşturulması ve özelliklerinin belirlenmesi 

• Verilerin kopyalanıp yapıştırılması, import, export vb şekilde yönetilmesi 

• Veri tabanı özellikleri olan Subtypes, Domain, Relationship, Topology, Network Dataset, 
Geometric Network vb. fonksiyonların tanımlanması 

• ArcMap ve ArcToolbox arayüzlerine verilerin sürüklenip bırakılması ve yönetilmesi 

• Verilere ait tanımlayıcı bilgilerin Item Description olarak belirlenmesi 

• İlişkisel Veri Tabanı Yönetim Sistemlerine(IVTYS) doğrudan bağlantı kurulması 

• ArcCatalog arayüzünde verilerin Preview fonksiyonu ile önizlenmesi 

• Windows Gezginine benzer şekilde verilerin görüntülenmesi, sıralanması ve yönetilmesi 
 



 
ArcCatalog’da ESRI Vektör Verilerinin Oluşturulması 

 
Shape File; ESRI’nin ArcView 3x Desktop GIS yazılımından itibaren ürettiği grafik ve sözel veri depolayan 
vektör veri formatıdır. Shapefile dosyaları Nokta(Point), Çizgi(Line) ve Alan(Polygon) veri tipleri olarak 
depolanır. Her katmanda bu grafik veri tiplerinden sadece bir tanesi tutulur. Katmanları veri tabanında 
.shp, .dbf ve .shx uzantılarıyla tutar. *shp; katmana ait grafik verilerinin tutulduğu dosya, *dbf; grafik 
veriye ait öznitelik bilgilerinin tutulduğu dosya, *shx; grafik veri ile sözel veri arasındaki ilişkiyi sağlayan 
index dosyasıdır. 

 
Geodatabase Feature Class; Nokta, Çizgi ve Alan veri tipleri olarak tanımlanan grafik özellikler, File veya 
Personal Geodatabase, ArcSDE Geodatabase içerisinde depolanır. Personal Geodatabase Ms Access veri 
tabanında, ArcSDE Geodatabase ise İlişkisel Veri Tabanı Yönetim Sistemi(IVTYS) olarak adlandırılan 
Oracle, Informix, SQL Server, IBM DB2... veri tabanlarında depolanarak yönetimi sağlanabilen ESRI 
vektör veri formatıdır. Shapefile formatına göre yeni bir formattır. Nokta, Çizgi ve Alana ait grafik veri ve 
buna bağlı öznitelik verileri coğrafi veritabanında tutulur.  
 

1. Başlat > Tüm Programlar > ArcGIS’i seçiniz. ArcCatalog 10 ayrı bir arayüz olarak görünmektedir. 
Fakat bu uygulamamızda ArcMap arayüzündeki Catalog penceresinde tüm  ArcCatalog 
işlemlerine ait fonksiyonları araştıracağız. ArcMap 10’u açınız. 
 

 
 

2. Gelen ekranda aşağıdaki gibi boş bir sayfa açılması seçeneğini seçerek OK’i tıklayınız. 
 

 



Açılacak olan Blank Map haritası için varsayılan bir geodatabase mevcuttur. ArcGIS Desktop 
kurulduktan sonra Default.gdb coğrafi veri tabanı  otomatik olarak oluşturulmakta ve 
katmanların kaydı sırasında varsayılan olarak bu geodatabase kullanılmaktadır.  
Default.gdb’e  Catalog penceresindeki üst menüden kısayol olarak ulaşılabilir. Boş harita 
üzerinde kullanıcının boş bir geodatabase açmasına gerek kalmadan kendisi varsayılan olarak bu 
geodatabase içine katmanları oluşturabilmektedir.  
 

 
 

3. ArcCatalog  penceresini açınız. Bir önceki uygulamada rektifiye ettiğimiz raster üzerinde 
veritabanı oluşturmak için; 
Folder Connections > C:/ArcGIS10_EGITIM/Uygulama_07/REC_f22d22d3c.tif dosyasını Table of 
Contents’e sürükleyip bırakınız. 
 

   
 
 

 



4. Default.gdb üzerinde mouse’un sağ tuşuna tıklayarak New > Feature Dataset’i tıklayınız. 
Feature Dataset; aynı projeksiyon sisteminde oluşturulacak birden fazla feature class için 
kullanışlıdır. Name kısmına f22d22 yazınız. Next’i tıklayınız. Koordinat sistemi ayarlarını aşağıdaki 
gibi Import ederek alınız. Diğer ekranlarda da Next’i tıklayınız. Finish’i seçiniz. 

      
 

5. Oluşturduğunuz f22d22 feature dataset’i içerisinde bu pafta üzerinde sayısallaştıracağımız 
katmanları oluşturmak için sağ tıklayınız New > Feature Class seçeneğine tıklayınız. Yeni 
oluşturacağımız Imar Cephe çizgi katmanı için ayarları aşağıdaki gibi yapınız. Imar Cephe 
katmanının çizgi olmasını istediğimiz için Type seçeneği Line Feature olarak ayarlanmıştır. Next’i 
tıklayınız. 
 

   



 
6. Default.gdb üzerinde veri depolama seçenekleri “Use configuration keyword” özelliğinden isteğe 

göre değiştirilebilir. Hiçbir değişiklik yapmadan Next’i tıklayınız. 
 

7. Grafik veriye ait sözel bilgiler için bu kısımda öznitelik field başlıkları oluşturulacaktır. 
Imar_cephe feature class’ına veri girişi yapılırken hangi özniteliklerin veri tabanına eklenmesi 
isteniyorsa başlıkları bu seçenekte eklenir. Bu katmana ait field tanımlamasını aşağıdaki gibi 
yapınız. 
 

   
 

8. Finish’i tıklayınız. Catalog penceresinde Default.gdb > f22d22 feature dataset > Imar_Cephe çizgi 
feature class’ını oluşturmuş olduk.  Henüz oluşturulan Imar_cephe Table of Contents’ de 
doğrudan eklenmiş olarak gelmektedir. 
 

 
 



9. f22d22 feature dataset üzerinde tekrar sağ tıklayarak New > Feature Class’ı seçiniz. Aynı işlemler 
Imar_Alan katmanı için de yapılacaktır. Ayarlamaları aşağıdaki gibi yaparak Imar_Alan alan 
katmanını oluşturunuz. 
 

   
 
10. Direkler(Point) ve Binalar(Polygon) katmanlarını aşağıdaki şekillerde oluşturunuz. 

 

  
 Direkler katmanı için Binalar katmanı için 
 

11. En son oluşturulan katmanın öznitelik field başlıklarından SHAPE’i yanındaki gri küçük kutucuğa 
tıklayarak seçiniz. Seçili olan Field Name’e ait özellikler pencerenin altında görüntülenecektir. 
Shape field’ı oluşturan geometri özellikleri Field Properties kısmında görüntülenmektedir. 
  

   
        



           Bu işlemler ile veri tabanı tasarımı gerçekleştirilmiştir.Bu aşamadan sonra pafta 
sayısallaştırılacaktır.  
 

 
 

Uygulama 9 : Veri Girişi ve Güncelleme 

Oluşturulan veri tabanına veri girişi yapma işlemine sayısallaştırma denilmektedir. Sayısallaştırma işlemi 
ESRI vektör veri tipleri olan Shapfile ve Geodatabase Feature Classlara ait gerekli güncellemelerin 
yapılarak veri tabanına sözel bilgilerinin de eklenmesini içermektedir.  
ArcGIS 10 versionundan itibaren güncelleme işlemi için kullanılacak Editing araçları güçlendirilerek 
geliştirilmiştir. Artık CAD kabiliyetinde çizimler çok daha rahat bir şekilde yapılmaktadır. 
 

1. Bir önceki uygulamada Default.gdb içerisine oluşturduğunuz katmanlar ve Rektifiye ettiğimiz 
altlık raster verinin(REC_f22d22d3c.tif) halen ArcMap’te bulunduğundan emin olunuz. 
 

2. Standard araç çubuğunda bulunan  Editor araç çubuğunu açmayı sağlayan Editor Toolbar aracını 

 tıklayınız. Vektör veriler üzerinde güncelleme yapmamıza olanak sağlayan Editor araç 
çubuğu ekrana gelecektir. 
 

3. Katmanlar üzerinde veri girişi yapılması işlemini başlatmak için Editor > Start Editing’i tıklayınız. 
Ekrana Create Features penceresi gelecektir. Bu pencere ile veri girişi yapılacak katmanı seçerek 
ekran üzerinden sayısallaştırma yapılmaktadır.  
 
 



 
 

4. Imar_Alan polygon katmanını seçiniz. Imar_Alan katmanı seçildikten sonra aşağıda Construction 
Tools seçeneğinde Polygon’u seçiniz. 
 

         
 

5. Data View ekranında pafta üzerinde imar alanı olarak sayısallaştırılacak kenar kısımlara mouse 
ile tıklanarak çizim yapılır. Feature oluştururken tıklanılan her noktaya yeşil renkli atılan 
noktalara Vertex adı verilmektedir. Vertexler ile çizimi istenilen şekilde değiştirebilirsiniz. Bunun 
için çizim sırasında Feature Construction araç çubuğu ekrana gelmektedir. Çizimi sonlandırmak 
için klavyenizden F2 tuşuna basınız. 
 



 
 

6. Benzer şekilde Imar Alan çizimine devam ediniz. 
 

 
 

7. Çizimi yaparken Editor araç çubuğu üzerinde bulunan Attributes aracını  tıklayınız. Açılan 
Attributes penceresi saklanabilir olarak ekrana gelmektedir. Öznitelik değerleri ekranda seçili 
olan feature için doldurulur. İmar alan olan yerleri sayısallaştırmayı ve öznitelik bilgilerini 
doldurmayı sürdürünüz. 
 

 
 

8. Create Feature saklanabilir penceresini çağırınız. Binalar katmanı seçiniz ve pafta üzerindeki 
binaları sayısallaştırarak veri girişi yapmaya başlayınız. 



           
 

9. Pafta üzerinde bina sayısallaştırmaya başlayınız. Çizim yaparken açılan Feature Construction 
penceresindeki yardımcı çizim elemanları kullanılacaktır. Aşağıdaki gibi binaya yakınlaşınız ve 
çizim yapmaya başlayınız, Constrain Perpendicular aracını seçerek dik çizmek istediğiniz çizgiyi 
seçiniz. Aynı çizgiye devamında paralel çizmek için Constrain Parallel aracını seçerek çiziniz. 
 

     
 
 
Çizimi bu araçlarla sürdürünüz ve F2ye basarak(yada mouse’a çift tıklayarak) çizimi sonlandırınız. 
 



 
 

10. Create Feature saklanabilir penceresini tekrar çağırınız. Imar_Cephe katmanı seçiniz. 
Construction Tools seçeneğinde çizgi feature çizimi yapmayı sağlayan araçların geldiği 
görülmektedir. Line’ı seçiniz. 
 

    
 
Pafta üzerinde sayısallaştırmak istediğiniz imar cephesine yakınlaşınız ve çizim yaparak öznitelikleri 
doldurunuz. Çizimi tamamladıktan vertexleri görüntülemek ve çizimde değişiklik yapmak için çift 



tıklayabilirsiniz. Vertexler görüntülenirken Edit Vertices araç çubuğu ekrana gelir. Vertex üzerindeki 
değişikleri buradan yapabilirsiniz. 
 

 
 

11. Yapılan güncelleme işlemlerini kaydetmek için Editor araççubuğunda Editor > Save Editing 
seçeneğini tıklayınız. Güncelleme işlemini sonlandırmak için Editor > Stop Editing  aracına 
tıklayınız. Böylece veri tabanını oluşturduğumuz katmanlara veri girişi yapılmıştır. Daha sonra bu 
verilere ekleme ya da düzenleme yapılmak istenildiğinde Start Editing seçeneğini seçerek araç 
çubuğunu aktif hale getirmemiz gerekmektedir. 

         
 

12. ArcMap’te çalışılan projeye daha sonra aynı semboloji ile devam etmek isteniliyorsa MXD olarak 
kaydedilmesi gerekir. 
File > Save As seçiniz. Projeyi C:/ArcGIS10_EGITIM/Uygulama_09 klasörü içerisine F22D22.mxd 
olarak kaydediniz ve ArcMap’i kapatınız. 
 

Uygulama 10 :  

Veri Güncelleme ve Sayısallaştırma Kabiliyetleri; 

Bu uygulamada, veri güncelleme işlemi sırasında sayısallaştırma işlemini sağlayan bazı ileri düzey 
araçlar gösterilecektir.  
 



1. Başlat > Tüm Programlar > ArcGIS > ArcMap 10 seçerek C:/ArcGIS10_EGITIM/Uygulama_09 
klasöründe bulunan Uygulama_09.mxd dosyasını açınız.  
 

 
 

2. Editor araççubuğunu çağırınız ve Editor > Start Editing’i seçiniz. Binalar katmanındaki 
çizilmiş bazı featureları olması gereken koordinatlara taşımak için Editor araççubuğu 

üzerindeki Edit Tool  aracını  seçerek feature üzerinde tıklayınız. Mavi renkte seçili hale 
gelen feature’ı mouse ile tutup harita üzerindeki koordinatlarına taşıyınız. 
 

  
 

3. Farklı yönde döndürülmüş featureları Rotate aracını  kullanarak doğru açıyı almasını 
sağlayınız. 

 
 

4. Create Features saklanabilir penceresinden Binalar katmanını seçerek sayısallaşmamış iki 
adet binayı ekran üzerinden mouse ile tıklayarak sayısallaştırınız. Sayısallaştırma işlemini 
yaparken Constrain Parallel ve Constrain Perpendicular araçlarını kullanarak çizim yapınız 
ve F2’ye basarak çizimi sonlandırınız. 
 



 
 

Çizdiğimiz binaların bulunduğu yere ait parselin araziden alınan koordinat ve ölçüm değerleri 
bulunmaktadır. Bu değerler ile Parsel sayısallaştırma yapılacaktır.  
 

5. Create Features penceresinde Parseller katmanını seçiniz ve Data View ekranında mouse ile 
sağ tıklayarak “Absolute X,Y” seçeneğine tıklayınız (Klavye kısayolu F6’dır). İlk noktanın X ve 
Y koordinatlarını aşağıdaki gibi yazınız. Enter’a basınız.  
 

  
 

6. Harita üzerinde girilen koordinatlara vertex atılmış olarak gelmektedir. Bu vertex’e göre açı 
ve mesafe değeri girilerek çizim yapılacaktır. Bunun için mouse ile sağ tıklayarak 
Direction/Lenght seçeneğine tıklayınız (Klavye kısayolu Ctrl+G’dir). Aşağıdaki değerleri 
yazarak Enter’a basınız. 
 

      



 
7. Parsele ait üçüncü noktaya ait koordinat değeri bilinmektedir. Klavyeden F6’ya basarak 

aşağıdaki değerleri yazınız ve Enter’a basınız. 
 

 
 

8. Parsele ait dördüncü nokta belli bir eğimle çizilecektir. Bunun için mouse ile sağ tıklayarak 
Tangent Curve seçeneğine tıklayınız ve aşağıdaki değerleri ayarlayınız. Enter’a basınız. 
 

       
 

9. Dördüncü noktaya göre belli bir açı ve mesafe değerine göre beşinci son nokta 
belirlenecektir. Klavyeden Ctrl+G’yi tıklayarak aşağıdaki değerleri giriniz. Enter’a basınız. 

 
 

10. Çizimi bitirmek için F2’ye basınız. 
 

11. Parsel çiziminde değişiklik yapmak için Vertexler üzerinde değişiklikler yapılır. Değişiklik 
yapmak için katman üzerinde sağ tıklayarak Edit Vertices seçip Sketch Properties 
penceresini açabilirsiniz. 
 



 
 
12. Oluşturduğumuz parsel katmanının öznitelik bilgilerini doldurmak için Attributes Table’ı 

açınız ve ParselRef field’ına 1 yazınız. 
 

 
 

13. Çizerek oluşturduğumuz parselin üzerinde bulunan 9  adet binayı Edit Tool  ile seçiniz. 
Seçili olan tüm binalar aynı parsel referans değerine sahip olduklarından dolayı ParselRef 
öznitelik değeri aynı olacaktır. Öznitelik tablosunda aynı değeri toplu şekilde yazdırmak için 
Binalar katmanı üzerinde sağ tıklayarak Open Attributes Table’ı seçiniz. Açılan Table 



penceresinde sadece seçili olanları göstermek için pencerenin en altında bulunan Show 
Selected Records seçeneğini seçiniz. 
 

 
 
14. Binalar öznitelik tablosunda ParselRef Field’ını bulunuz ve başlık üzerinde sağ tıklayarak 

Field Calculator’u seçiniz. Sadece seçili olan objeler için işlem yapacak olan Field Calculator 
penceresinde 1 yazınız ve  OK’i tıklayınız. 

   



 
 

Editing işlemi sırasında görüntüyü oynattığımız zaman altlık olarak kullanılan raster veya 
diğer katmanların tekrar ekranda açılma hızı veri boyutuna göre yavaş olarak 
gelebilmektedir. Bu işlemi hızlandırmak için ArcGIS 10 verisonundan itibaren Basemap 
Layer’lar oluşturulabilmektedir.  
 

15. Layers veri çerçevesi üzerinde sağ tıklayarak New Basemap Layer’ı seçiniz. Table of 
Contents’e gelen New Basemap Layer’a Ankara.img altlık raster veriyi sürükleyip bırakınız.  
 

      

 

16. Yol_Orta çizgi katmanını açınız. Görüntülenebilirliği aktif olarak gelen katman Create 
Features penceresinde de görüntülenebilir olarak gelmektedir. Yol_orta katmanını Çizgi 
çizim şeklini seçecek şekilde tıklayınız.  Aşağıdaki gibi yol katmanı çizilecek olan kısma 
yakınlaşınız. Kesişim noktasına yakınlaştığınız zaman otomatik yakalama(snap) yapmaktadır. 
Kesişim noktasını tıklayınız ve yolu aşağıdaki gibi çiziniz. Görüntünün ekrana sığmadığı yerde 
ilerletme yaparken altlık raster veri Basemap olarak ayarladığından dolayı hızlı bir şekilde 
ekrana gelmektedir. Snapping işlemlerini özelleştirmek için Customize > Toolbars > 
Snapping araççubuğunu çağırabilirsiniz. 
 



 
 

17. Güncelleme işlemi tamamlandıktan sonra Editor araç çubuğu üzerinde Editor > Save Edits’i 
ve ardından  Editor > Stop Editing’i seçiniz. Projeyi kaydederek  ArcMap’i kapatınız. 

 

 

Uygulama 11 :  

Diğer güncelleme araçları; 

Coğrafi Bilgi Sistemlerinin parçası olarak güncelleme işleminde yapılacak işlemleri kolaylaştıracak 
farklı fonksiyonlar mevcuttur. Editing araçları olarak adlandırılan bu fonksiyonlar ile vektör veri 
oluşturmada kolaylıklar sağlanmaktadır. 
 

1. Başlat > Tüm Programlar > ArcGIS > ArcMap 10’u açınız. Uygulama veri setleri içinde bulunan 
C:/ArcGIS10_EGITIM/Uygulama_10/Uygulama_10.mxd’yi açınız. Açılan haritada Parsel, Refuj, 
Elektrik Direkleri, Elektrik Hattı katmanları Table of Contents menüsüne gelecektir. 
 

 
 

2. Editor araç çubuğu bir önceki uygulamada arayüze eklendiği için ekrana gelmiştir. Eğer 

gelmediyse Editor araç çubuğunu  tıklayarak çağırınız. Editor > Start Editing’i seçerek 
güncelleme işlemleri için Editing araç çubuklarını aktif hale getiriniz. Açılan Create Features 

penceresinin sağ üst köşesindeki Auto Hide aracını  tıklayarak pencereyi saklayınız. 
 

 
 

3. Refujlerin oluşturduğu yolun ortasından elektrik hattı geçmektedir. Refuj’e paralel olacak şekilde 
Elektrik Hattı feature’ı kopyalamak için önce Refuj katmanındaki hangi feature’a paralel 

oluşturmak isteniyorsa, onu Edit Tool aracıyla  seçiniz. Editor araç çubuğunda Editor > Copy 



Parallel seçeneğini seçiniz. Açılan Copy Parallel penceresinde aşağıdaki ayarlamaları yapınız. 
OK’i tıklayınız. Bu ayarlar ile seçili refuj feature’ının 4m ok yönüne göre sağ tarafına elektrik hattı 
feature’ı kopyalanacaktır. 
 

     
 

4. Oluşturulan elektrik hattı feature’ını Edit Tool aracıyla  seçiniz. Elektrik hattı üzerine 10 
metre aralıklarla elektrik direkleri yerleştirilecektir. Bunun için Editor > Construct Points 
seçeneğini seçiniz ve aşağıdaki şekilde ayarlamalar yaparak OK’i tıklayınız. 
 

  



 

 
 

5. Birden fazla feature’ı birleştirerek tek bir feature haline getirmek için Merge aracı 

kullanılmaktadır. Aşağıdaki gibi birden fazla parsel’i Edit Tool  ile seçiniz. Editor araç 
çubuğunda Editor > Merge fonksiyonunu seçiniz. Açılan pencerede birleştirme sonucunda hangi 
feature’ın öznitelik tablosundaki bilgiler alınması istenildiğini seçerek OK’i tıklayınız. 
 



      
 

6. Create Feature penceresinden Refuj çizgi katmanını seçiniz. Editor  araç çubuğunda bulunan 
Trace aracını seçiniz ve parsellerin sol tarafında mouse ile tıklayarak refujun açılacağı güzergahta 
sadece mouse’u hareket ettiriniz ve bittiği tarafın dışarısında mouse ile çift tıklayarak çizimi 
sonlandırınız. 
 

  
 

7. Çizilen Refuj etrafındaki parselleri belli bir mesafede kesmek için Clip fonksiyonu 
kullanılmaktadır. Editor araç çubuğunda Clip aracını seçiniz ve aşağıdaki değerleri yazarak OK’i 
tıklayınız. 



 

 
 

8. Editor araç çubuğundan Save Edits ve Stop Editing ile kaydederek güncellemeyi sonlandırınız. 
Projeyi  ayrıca mxd olarak kaydederek ArcMap’i kapatınız. 
 

Uygulama 12 :  

Veri Dönüşüm Fonksiyonları; 

DWG,DXF ve DGN gibi çok kullanılan CAD formatları ArcGIS teknolojisi ürünleri ArcView,ArcEditor ve 
ArcInfo yazılımları ile direk olarak görüntülenebilmektedir. 

CAD veri formatında depolanan vektör veri yapısını farklı yöntemler kullanarak ArcGIS vektör veri 
formatlarına çevirmek mümkündür.CAD formatlarının, ESRI Shape file ve Feature Class  dönüşüm 
işlemleri ArcMap ve ArcToolBox arayüzlerinde bulunan fonksiyonlar sayesinde daha pratik ve esnek bir 
şekilde yapılabilmektedir. 

Özellik tipleri Line,Point,Polygon ve Annotation olan bir çizim dosyasında depolanan CAD veri 
formatlarının, coğrafi detayları ise CAD formatlarında (DWG ve DGN) Layer ve/veya Level’larda 
sınıflandırılarak sayısallaştırma işlemleri gerçekleştirilir.CAD verileri ArcGIS teknolojisinde aşağıdaki 
şekilde temsil edilmektedir.  

 



                                

 

 

1. ArcMap 10  arayüzünü açınız. 
 

 
 

2. ArcGIS10_Egitim/Uygulama_11 dosyasında yer alan Uygulama_11.mxd’yi açınız. (Bu uygulama 
için 1022.dgn verisinin Polyline, Polygon ve Point katmanları Add Data butonu ile ArcMap 
ortamına eklenip mxd olarak kaydedilmiştir.) 

 

 

 

3. Table of Contents’de bulunan 1022.dgn Point ve 1022.dgn Polyline katmanlarının visible çekini 
kaldırarak görünmez hale getiriniz.1022.dgn Polygon üzerinde mouse ile sağ tıklayıp Katman 
Özellikleri (properties) penceresini seçiniz. 
 



 
 

4. Açılan pencerede Drawing Layers sekmesinde,tüm katman özelliklerini Disable All butonuna 
basarak kapatınız. 

 

        

 

 



5. Daha sonra Layer 25 katmanının  çekini atarak Enable durumuna getiriniz. OK butonuna 
tıkladığınızda Polygon özellik tipini taşıyan Layer 25 katmanında çizilen binaları harita sayfasında 
görecesiniz. 

        

6. Table of Contents’de yer alan 1022.dgn Polygon katmanı üzerinde mouse’un sağ tuşuna basınız. 
Data > Export Data fonksiyonunu seçiniz. 

 

Export Data işlemi ile 1022.dgn Polygon katmanında bulunan tüm objeleri katmanın sahip 
olduğu koordinat sistemini koruyarak Shapefile veya Feature Class’a çevirmek mümkündür. 
 



7. Browse   aracına tıklayarak bilgisayarınızda dosyanın kaydedilmesini istediğiniz yeri 
belirleyiniz. 
 

     

 
Oluşturulması düşünülen bina katmanı büyük ölçekli harita uygulamalarında alansal 
vektör(Feature Type:Polygon) tipine sahip olmalıdır.CAD ortamında çizilen objeler için ise 
yukarıda anlatılan işlemler sonucunda alansal vektör tipi elde edilebilir.CAD ortamındaki alan 
ifade etmesi istenen objeler Close Polygon olarak çizilir.Coğrafi Bilgi Sistemleri içerisinde alan 
olarak tanımlanması istenilen CAD verileri çoğu zaman polygon olarak tanımlanamaz.Bu veriler 
CAD ortamında genelde Polyline olarak üretilir.Bu verilerin Polyline olarak tasarlanmış yapısını 
Export işlemi ile Line vektörel tipine çevrilir.Bu işlem sonucunda verilerde çizim hatası var ise 
hataları düzeltmek ve çizgi özelliğini daha sonra alan özelliğine dönüştürmek gerekecektir.Bu 
bölümde dönüşüm işlemleri uygulamalı olarak işlenecektir. 
 

8. Table of Contents’de yer alan ve daha önce visible çekini kaldırdığımız 1022.dgn Point ve 
1022.dgn Polygon katmanlarının çeklerini tekrar aktif hale getiriniz.1022.dgn Polyline katmanı 
üzerinde mouse ile sağ tuşa tıklayıp Properties seçeneğini seçiniz. 
 



 

 

  

9. Layer properties penceresindeki Drawing Layers sekmesini seçiniz.Tüm katman özelliklerini 
Disable All butonuna tıklayarak kapatınız.Daha sonra Layer 61 katmanının çekini atarak Enable 
duruma getiriniz. 
 

 
 

  



10. Table of Contents’de bulunan 1022.dgn Polyline katmanı üzerinde mouse’un sağ tuşuna 
tıklayarak Data>Export Data fonksiyonunu seçiniz. 

11. Export Data fonksiyonu ile 1022.dgn Polyline katmanında bulunan tüm objeleri,mevcut 
projeksiyon sistemine göre Shape File veya Feature Class olarak olarak dönüştürmek mümkün 

olacaktır.Export Data penceresindeki Browse  aracına tıklayınız. 
 

 
 

12. 61’inci Layer’da yer alan Polyline objelerini, Uygulama_11 dosyası altına BinalarLine Shapefile  
olarak kaydediniz.  
Bu aşamada çizgi özelliğinde gelen yeni BinalarLine katmanını poligona çevirmemiz 
gerekmektedir. Bu işlem için ArcToolBox’daki Feature To Polygon fonksiyonu kullanılacaktır.  
ArcGIS 10’dan itibaren ArcToolbox’daki fonksiyonlar Search penceresinden kolaylıkla 
aratılabilmektedir.  
 

13. Standard araç çubuğundaki Search  aracına tıklayarak Search penceresini açınız.  
14. Açılan Search penceresinde Tool seçeneğini seçiniz.  

 



 
 

15. Arama kutucuğuna Feature To Polygon yazıp Enter’a tıklayınız. 
 

 
 

16. Listeden Feature To Polygon fonksiyonuna tıklayıp Feature To Polygon penceresinin açılmasını 
sağlayınız.  

17. Ayarları şekildeki gibi yaptıktan sonra OK butonuna tıklayınız.  Çizgi katmanındaki binalarınızın 
alan katmanına dönüştüğünü göreceksiniz.  
 



 
 

18. 1022.dgn Point katmanında yer alan noktasal verilerin birbirinden ayırtedici özelliği Text 
Field’ında yer alan öznitelik değerleridir. Text Field’ı  AGAC olarak tanımlı olan objeleri Select By 
Attributes fonksiyonu ile seçiniz. 
 

 
 

19. Seçili olan objeleri ağaç katmanı olarak export etmek için Table of Contents’de Point üzerinde 
sağ tıklayarak Export > Export Data seçeneğine tıklayınız. Daha sonra Agac adı altında veriyi 
Shapefile olarak kaydediniz.  
 

20. ArcMap’i kapatınız.  



Noktasal Ölçüm Değerlerinin Görüntülenmesi; 

 
GPS,TotalStation gibi ölçüm cihazları ile elde edilen koordinat bilgileri,sayısal olarak sistemde Dbase, 
Excel, ASCII Text File  gibi farklı formatlarda depolanabilirler. ArcGIS ortamında, bu formatlardaki 
verilerin ESRI vektör formatlarına dönüşümü mümkündür. 

Bu bölümdeki uygulamada X,Y koordinat değerlerinin bulunduğu Dbase ve Excel dosyalarının, ESRI Shape 
File formatına dönüşümü işlemleri ArcMap arayüzünde gerçekleştirilecektir. 

 
Add XY Data Fonksiyonu; 

Dbase formatında yer alan koordinat bilgilerinden, Shapefile formatında dönüşüm işlemleri ArcMap 
arayüzünde Add XY Data Fonksiyonu ile gerçekleştirilmektedir. 

1. ArcMap10  arayüzünde boş bir harita sayfası açınız.  
 

 
 

2. File > Add Data > Add XY Data seçeneğine tıklayınız.  
 

 
 

3. Açılan pencerede “Choose a table from the map or browse for another table” kısmındaki  

Browse  aracına tıklayıp Uygulama_11 dosyası içerisindeki Parsel_Kose_Dbase.dbf dosyasını 
seçiniz ve Add butonuna tıklayınız.  



 

 

4. Add XY Data penceresinde X Field ve Y Field’da aşağıdaki sütün isimlerini seçip OK butonuna 
tıklayınız. 

 

 
 

5. Yaptığınız bu işlem sonucunda Parsel_Kose_Dbase.dbf dosyasında yer alan X ve Y koordinat 
değerleri temsilen ArcMap harita sayfasında Parsel_Kose_Dbase_Events formatında 
görüntülenecektir. 
 

 
 

6. Bu dosyalar Export Data yöntemi ile Shapefile veya Feature Class olarak kaydedilebilmektedir. 
Bunun için Parsel_Kose_Dbase_Events katmanı üzerinde mouse’un sağ tuşuna tıklayarak 



Data>Export Data fonksiyonunu seçiniz ve Uygulama_11 dosyasının içine,Parsel_Dbase Shape 
File olarak kaydediniz. 
 

 
 
 

7. ArcMap’ten çıkınız. 
                                    

Uygulama 13: 

Zaman Bilgisi ile animasyon oluşturma; 

ArcGIS 10 vekör ve raster verilerde zaman bilgisini desteklemektedir. Bu uygulamada, vektör veriler 
üzerinde Osmanlı  Devleti’nin Yükselme, Duraklama ve Gerileme Devirlerindeki toprak büyüklükleri 
animasyon haline getirilecektir.  

 

1. ArcGIS10_EGITIM/Uygulama_12 klasöründe yer alan Uygulama_12.mxd’yi ArcMap’te açınız.  
 

 
 
Table of Contents’de Osmanlı, Ulkeler  vektörel katmanlarının ve ESRI Terrain Basemap’inin 
olduğunu göreceksiniz.  
 

2. Osmanli katmanında sağ tıklayınız ve Open Attribute Table seçeneğine tıklayınız.  
 



 
 
Öznitelik tablosunda,  yil field’ı fetih yıllarını göstermektedir. tarih field’ı ise animasyonda 
kullanılmak üzere açılmıştır.  
 

3. Öznitelik tablosunu kapatınız.  
 

4. Osmanli katmanının kutusunun çekini atarak katmanın görüntülenmesini sağlayınız.  
 

5. Osmanli katmanında tekrar sağ tıklayarak Properties seçeneğine tıklayınız.  
 

 
 

6. Layer Properties penceresinde Time sekmesine tıklayınız. 
 

7. Time sekmesinde Enable time on this layer kutusunun çekini atınız. 
 

8. Layer Time kısmından Each feature has a single field seçeneğini seçiniz.  
 

9. Time field kısmından “tarih” field’ını seçiniz. 
 

10. Time Step Interval kısmını şekilde olduğu gibi 1 Day olarak ayarlayınız ve OK butonuna tıklayarak 
katman Özellikleri penceresini kapatınız.  
 



 
 

11. Tools Toolbar’daki Open Time Slider Window  aracına tıklayınız.  
 

12. Time Slider Window penceresinden Play butonuna tıklayınız ve animasyonu başlatınız.  
 

 
 

 



13. Daha sonra bu animasyonu .avi formatında video olarak kaydetmek için Export to Video aracına 
tıklayınız. 
 

 
 

14. Export Animation penceresinden videoyu kaydedeceğiniz yeri seçiniz ve isim veriniz.  
15. Export butonuna tıklayınız.  

 

 
 

16. Açılan Video Compression penceresinde OK butonuna tıklayınız.  
 

 
 
Bu aşamada videonuz bilgisayarınıza kaydedilecektir.  Ekranın altında videonun %100’ü 
oluşturulana kadar bekleyiniz.  Daha sonra videoyu izleyebilirsiniz.  

 
 



Uygulama 14:  
 
ArcMap’te Map Package oluşturulması; 
 
Bu uygulamada, arcgis.com’a üye olarak haritaların web üzerinden paylaşımı gösterilecektir. 
Bunun için tüm kullanıcılar arcgis.com adresinde kendileri için birer hesap oluşturacak daha 
sonra İslem grubuna üye olacaklardır. Bu aşamadan sonra hazırladıkları tüm harita ve katmanları 
internet üzerinden kolaylıkla paylaşabileceklerdir.   
 
1. ArcGIS10_EGITIM klasöründe yer alan Uygulama_13.mxd’yi ArcMap’te açınız.  
2. Haritanın sembolojisini dilediğiniz gibi ayarlayınız.  
3. File menüsünün altından Create Map Package seçeneğine tıklayınız.  

 

 
 

4. Açılan pencerede Save package to file seçeneğini seçtikten sonra Browse  aracına 
tıklayınız.  
 

 
 

5. Harita paketini C:\ ArcGIS10_EGITIM\Uygulama_13 dosyasının içerisine isim vererek 
kaydediniz.  



 
6. Validate butonuna tıklayınız.  

 
7. Daha sonra Share butonuna tıklayınız.  

 
8. Açılan pencerede Yes butonuna basınız.  

 

 
 

9. Harita paketinizin başarılı bir şekilde oluşturulduğunu gösteren mesaj kutusunda OK 
butonuna tıklayınız.  
 

 
 
 
ArcGIS.com’a  Üyelik; 
 
10. Kullandığınız Web Browser’da adres çubuğuna www.arcgis.com yazınız.  

 

http://www.arcgis.com/�


 
 

11. www.arcgis.com  sayfası açıldıktan sonra sağ üst köşedeki Sign In butonuna tıklayınız. 
  

12. Açılan sayfada sağ taraftaki Don’t have an ESRI Global Account? Başlığı altındaki Create an 
account seçeneğine tıklayınız.  
 

 
 

13. Açılan sayfada üye olmanız için gerekli olan bilgileri doldurmanız gerekmektedir. Bilgileri 
eksiksiz olarak doldurduktan sonra Create My ESRI Global Account butonuna basınız.  
 

 

islemegitim 

http://www.arcgis.com/�


 
 

 
 

14. Aşağıdaki sayfa açıldıktan sonra kayıt yaparken veriğiniz mail hesabınızı açınız. ESRI’nin 
göndermiş olduğu maildeki linke tıklayarak hesabınızı aktif hale getiriniz.  
 

 
 

15. Linke tıkladıktan sonra açılan sayfada şifreyi giriniz ve Finish butonuna basarak kayıt işlemini 
sonlandırınız.  
 

 
16. Daha sonra açılan ekranda oluşturmuş olduğunuz hesap bilgilerini giriniz ve Register 

butonuna tıklayınız.  
 



 
17. ArcGIS.com kullanım koşullarını kabul etmek için açılan pencerede I Accept butonuna 

basınız.  
 

 
 
Dilerseniz kullanıcı hesabınızdaki bilgileri doldurabilir ve resminizi ekleyebilirsiniz.  
 

ArcGIS.com’da  İslem Grubu’na Üyelik; 
 
Bu eğitim sonucunda, tüm katılımcıların ArcGIS.com’da bulunan İslem Grubu’na üye olmaları 
ve ilerde dilerlerse haritalarını grup üzerinden paylaşmaları amaçlanmaktadır. Bu nedenle, 
bu uygulamada katılımcıların gruba nasıl üye olacakları anlatılacaktır.  
 

18. Yukarıdaki araç çubuğundan Groups seçeneğine tıklayınız.  
 

 
19.  Search For kısmına İslem yazıp Enter’a basınız.  

 



 
 

20. Açılan listeden İslem Grubunu seçiniz.  
 

21. Daha sonra gruba katılmak için Join This Group butonuna tıklayınız.  
 

 
 

22. Ekranda açılan pencerede Submit  Request seçeneğine tıklayınız.  
 

 
 
Bu aşamadan sonra İslem Grup Yöneticisi üyeliklerinizi kabul edecektir.  
 

Oluşturulan Harita Paketinin web’e eklenmesi; 
 
23. Yukarıdaki araç çubuğundan My Content seçeneğine tıklayınız. 

 

 
 

24.  Açılan sayfada haritanızı web’e eklemek için Add Item butonuna tıklayınız. 
 

 
 

25. Daha sonra açılan pencerede Dosya Seç butonuna tıklayarak uygulamanın başında 
kaydettiğiniz harita paketini seçiniz.  
 



 
 

26. Tags kısmına, haritanızı bir başkası aratırken işine yarayacak olan anahtar kelimeleri yazınız 
ve Add Item butonuna basınız.  
 

27. Sayfanıza eklemiş olduğunuz haritanızı İslem Grubu üyeleriyle paylaşmak için Share 
butonuna tıklayınız.  
 

 
 

28. Share penceresinde islem kutusunun çekini atınız ve OK butonuna tıklayınız.  
 

 
 

29.  Böylece kendi oluşturduğunuz haritanıı web üzerinden diğer grup üyeleriyle paylaşmış 
oldunuz. Artık diğer grup üyelerinin ekledikleri haritaları inceleyebilirsiniz. 
 
 
 
 
 



 

 

 

 

 

 


